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SilkTest Interview Questions And Answers Guide.

Question - 1:
Can SilkTest run on Mac?

Ans:
Ya, you can. Except that you will need Mac Runtime for Java (MRJ).
View All Answers

Question - 2:
Is that because the RDC locks the desktop when I disconnect?

Ans:
.. We're running SilkTest scripts on our lab machines. The lab machines share a monitor through a KVM. We connect to the machines using Remote Desktop
Connection.
The scripts are being kicked off through a Windows Scheduled task. We're getting the message "Window cannot be set active".
It seems like if I login to the box in the lab then all is well, but if I've recently connected through Remote Desktop Connection the error occurs.
Is that because the RDC locks the desktop when I disconnect?
If I did a reboot before I run the scripts would that solve the problem?
I'm just trying to figure this out, so could be completely wrong on this.
So, any suggestions would be appreciated.
Answer1:
You should be able to adjust a setting for the task to 'wake' or 'unlock' the desktop prior to commencing the task. I recall having to do something like that in the past
when I did this.
Answer2:
It's because Windows Remote Desktop (WRD) appears to tell the OS that the video card is something other than the actual video card. This is because you have a
limited colour gamut using WRD. There are other limitations. When you disconnect, it seems to tell Windows on the guest machine that there's no video card at all
and it lets Windows figure out what's up the next time you log in.
One option that our network admin suggested was to use VNC instead. This would mean we would use a different method just to attach to the SilkTest machine we
have. It wasn't worth it for me, but it could be for you.
1) Your KVM switch has to be an electronic one because if it's not, the monitor won't have a screen rectangle. This was a limitation of the old hardware.
2) You have to circumvent the windows login screen and some security measures to get to the desktop which is where SilkTest will be running.
View All Answers

Question - 3:
What is AUT?

Ans:
AUT stands for Application Under Test.
View All Answers

Question - 4:
Does we need to make changes in window declaration dialog box?

Ans:
If two objects have the same logical name say for instance OK. How does silktest identifies the object, Does we need to make changes in window declaration dialog
box?
1. In anyone window two objects can not have same logical name, It will give compiler error.
2. OK objects have same logical name two times but for different window..
View All Answers

Question - 5:
How load testing can be done with silk international?

Ans:
Answer1:
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SilKTest is not a load testing tool - it is a functional testing tool. You could do a crude load test by having Silk on multiple boxes and then running each one at the
same time - but that is very crude.
You need Silk Performer or Load Runner or some other load testing tool for doing load testing.
Answer2:
Do some performance testing on a local binary.
Imagine trying to load ten large files into a word processor or text editor manually. If the procedure is to load one large file and when it has loaded load the next. If
performance degrades after each file has loaded. The first file takes 30 minutes to load, the second takes 75 minutes... This is a perfect candidate for using SilkTest
(or another functional GUI testing tool) to perform It won't get bored waiting and it will be ready to load the file as soon as it reads the "Ready" status.
You could run a series of image transformations in an image editor, recalculate a budget for a large company in financial package after changing a few variables, edit
a style sheet in a page layout and then scroll through the document, search and replace a single letter in a large text file, etc..
There are a lot of other single unit performance tests that can be run using SilkTest--use your imagination.
View All Answers

Question - 6:
Is there a way by which the different components within the calendar be recongnised by silktest?

Ans:
On web based application (developed in Java (jsp))., clicking on an icon opens up a calendar (pop-up calendar.js), which is a java applet, which is recognised by
Silktest but not the various components (Month drop down, year drop down) within it. Is there a way by which the different components within the calendar be
recongnised by silktest?
Try after enabling java extension....If you are using silk 7.x, try to do enable extension for the applet...It would copy the silktest java jar file to respective jvm....close
you application and restart....It should work.....
View All Answers

Question - 7:
To verify the file, the two files are same and also check whether the data in it is also correct How to do it using verify function?

Ans:
Answer1:
Use the SystemFunctions in that case
SYS_CompareText
eg.:
letscompare = SYS_CompareText(sFile1,sFile2)
Answer2:
Open SilkTest (7.6 version)
From the Help Menu, select Help Topics. In the SilkTest Help module, click on the Search Tab. Type in the word Verify and then press the ENTER key. A list is
displayed including, Verify function. Read that entry.
It explains how to use it and includes an example.
Answer3:
If ur text file is too big then follow this procedure
1) Read the actual text file and put the contents in a list (Say lsActual)
2)Read the expected text file and put the contents in a list (Say lsExpect)
And Read line by line and Print the mismatch line..
Check with the below code.It will work ..
[+] for ( iLine = 1 ; iLine <= ListCount (lsActContents) ;iLine ++ )
[ ]
[ ]
[-] if(lsActContents [ iLine] != lsExpContents [iLine])
[ ]
[ ]
[ ] bFailure = TRUE
[ ]
[ ]
[ ] fncLogMsg ( "Info", "The actual value in the {sActualFileVerified} text file " )
[ ]
[ ]
[ ] fncLogMsg ( "Info",
"{lsActContents [ iLine] }" )
[ ]
[ ]
[ ] fncLogMsg ( "Info",
"The expected value in the { sExpectedFileVerified } text file ")
[ ]
[ ]
[ ] fncLogMsg ( "Info",
"{lsExpContents [ iLine] }" )
[ ]
[ ]
[ ]
[ ]
View All Answers

Question - 8:
What I have to do to use the same scripts for web based testing?

Ans:
Same script can be used...Only URLs need to be updated....Might be some tags also but you can manage them using wild characters or multi-tag...
View All Answers
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Question - 9:
How to validate that the data inserted via silktest is successfully inserted and the record of each user is found in the database?

Ans:
Using silk test to create automated user registration application. How to validate that the data inserted via silktest is successfully inserted and the record of each user
is found in the database?
Answer1:
After inserting the record at the same time you can check that the record has been inserted or not.... say you are inserting the record with Insert statement (SQL) and
after insert statement you can validate whether the select statement returns any record or not. If it returns the proper record, proceed or display error or whatever you
wan't to do..
Answer2:
You can use database functions to connecto to your database and veryfy the data against the submitted data in the registration screen.
SilkTest supports relational data bases so you connect then through ODBC. check the help for db_connect(),db_fetch() etc. funtions
Answer3:
Your intention is to verify the data integrity in the DB for a single registration. There are couple of ways to do that. One being, if you have a list of registrations
provided from UI, after the registration is done successfully, go the listing page and select the particular record and go to the properties of it and compare the values
against the corresponding values given during the filling of registration form. The second way is that, try to write a query(as simple stored procedure) in the db that
displays all the values for a single registration and call that stored procedure from silk test using data driven functions. For the help on data driven functions, refer to
the online help. This is the only best way to learn silk test. You'll not find code samples on net.
View All Answers

Question - 10:
How to search for html link?

Ans:
A testcase for creating location. Silktest is reading location as html link. Locations are being stored alphabetically. But there is no tag associated with the latest tag
(suppose its cg11). How to search for html link?
Below function is related to HTML Table. This function checks whether passed link-name is HTML link or not. "this" paramter is refered as "HtmlTable".
[+] BOOLEAN IsHtmlLink(STRING sLinkName)
[+] do
[ ] INTEGER iColCnt=0,iRowCnt=0,iNextCCnt,iNextRCnt
[ ] BOOLEAN bflag=FALSE
[ ] iColCnt=this.GetColumnCount()
[ ] iRowCnt=this.GetRowCount()
[ ]
[-] for (iNextRCnt=1;iNextRCnt<=iRowCnt;iNextRCnt++)
[-] if !bflag
[-] for (iNextCCnt=1;iNextCCnt<=iColCnt;iNextCCnt++)
[-] if (this.HtmlColumn("#{iNextCCnt}").GetRowText(iNextRCnt) == sLinkName
)
[-] if (Trim(this.HtmlColumn("#{iNextCCnt}").HtmlLink("#{iNextRCnt}").GetLocation()) !="")
[ ] bflag=TRUE
[ ] break
[ ]
[-] else
[ ] break
[ ]
[ ] return (bflag)
[-] except
[ ] return (FALSE)
View All Answers

Question - 11:
How to launch 2 web application windows simultaneously thru Silktest?

Ans:
Testing a login feature for web application.
In the first window login will be successful, in the second window it will show error that user is already logged in.
But with the Recovery system set in SIlktest I can only launch One application window at a time.
How to launch 2 web application windows simultaneously thru Silktest?
Browser.Invoke ()
Browser.LoadPage ("URL for login screen")
Browser.WaitForReday ()
// Do login
Browser.Invoke ()
Agent.SetOption (OPT_VERIFY_UNIQUE, FALSE)
Browser.LoadPage ("URL for login screen")
Browser.WaitForReday ()
// Attempt to login and verify the message
Agent.SetOption (OPT_VERIFY_UNIQUE, TRUE)
Browser.TypeKeys ("<Alt-F4>")
View All Answers

Question - 12:
Executing more than one testcase. suppose in first testcase has one functions that is returning some string value. How to use first test case value into second test case?

Ans:
Answer1:
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At the top testcase , to declare something like:
create a global variable gPersonReferenceNumber and pass this into testcases as required.
void TestScriptSetup()
SetAppState ("YOURAPPSTATE")
gPersonReferenceNumber = CreateMinimalTestPerson()
testcase CallGlobalReference() appstate none
string sPersonString = gPersonReferenceNumber
etc
TestScriptSetUp() will be ran prior to CallGlobalReference. You can also include this into your recovery system if need be.
CreateMinimalTestPerson() returns a string value related to PersonID or whatever you would require
Answer2:
1. Use some public (global) variables to store your value
2. Writed testcase to return values, whatever you want and use it in later testcases..
Answer3:
To put it into an ini file or the registry.
Answer4:
Set the values in environment variables by SYS_SetEnv () and use them by SYS_GetEnv () wherever, whenever you want......Global variables also do this, but when
you call the test cases from a plan file, global variables get reset......
Other alternative are to store them in a file and use them .
View All Answers

Question - 13:
Whether it will help you to get good opportunities on Silk after certification?

Ans:
First of all it is very expensive ....( it cost around Level 1 - $150 + training - Rs 15000 +level 2 - $200)
Second you will learn indepth of silktest in the advanced training which is compulsory to take level 2 exam. Personally I felt this is useful even if you have 5 yrs
expericne in silktest you will learn more about complete tool.
Leavel 1 is online and they did not change the question papre for long time. I know few people who are scoring more than 95% just because of that.
Segue certification stratagy is not that great like mercury I felt very bad when I heard few people who doesn't know anytihng about silktest test did their certification.
(In india it too bad, I have no idea in another contries).
Sad part is there I konw some people who are able to take exam without paying fee also :( ( guess how strong their training division is )
Finally certification is only useful for decorating your cv. If you really have hands on experience in the tool no need go for certification.
View All Answers

Question - 14:
Trying to create a datadriven tests

Ans:
Trying to create a datadriven tests. Placed the .xls file in a data folder. The script should connect to the .xls file, open the file, read the contents in the .xls file and fill
the form with the values. I have written some steps using the Help guide. Its not working i get errors Can any one suggest me the list of steps and in which folder
these steps should go.
The following error:
C:Program FilesSegueSilkTestexamplesframe .inc(2): Window class BrowserChild is not defined or ambiguous
Database connectivity - Found word(s) list error in the Text body
the following error now:
Error: Variable (frmCompanyName) has not been set
Also I did the variable declaration as follows
[-] testcase DD_Test1 (REC_DATALIST_DD_Test1 rData)
[ ] STRING frmCompanyName
[ ] STRING Phone
[ ] STRING Contact
[ ] STRING Title
[ ] STRING Insights
[ ] STRING CoInsights
This looks like more of a scoping issue in Silktest than a problem with any DB connection to an excel file. Since I am heading out the door in just a few, I will have to
take a closer look at this tommorow but typically, my data driven scripts are structured sort of like:
[ ] //this reads the data from the spreadsheet and then iterates
[ ] use "P:Silkauincludesautoarch_temp.inc"
[ ]
[-] main()
[ ] HANDLE hDB
[ ] HANDLE hSQL
[ ] STRING sFirstName, sLastName, sAddress, sEmail, sComment, sExpected, sItem
[ ] INTEGER iCase, iPF, iRun
[ ] LIST OF STRING lsCases
[ ] STRING sQuery = "Select * from `Sheet1$`"
[ ] //open spreadsheet:
[ ] hDB = DB_connect ("DRIVER=Microsoft Excel Driver (*.xls);DBQ=P:QARelease11.1AUAutomationcontact_validation_words11_ 1.xls;
READONLY=FALSE")
[ ] hSQL = DB_ExecuteSQL(hDB, sQuery)
[-] while DB_FetchNext(hSQL, iCase, sFirstName, sLastName, sAddress, sEmail, sComment, sExpected, iPF, iRun)
[ ] //print("{iCase} {sFirstName} {sLastName} {sAddress} {sEmail} {iRun}")
[-] if iRun == 1
[ ] ListAppend(lsCases, "{iCase}|{sFirstName}|{sLastName}|{sAddress}|{sEmail}|{sComment}|{sExpec ted}|{iPF}|{iRun}")
[ ]
[ ] DB_FinishSql (hSQL)
[ ]
[-] for each sItem in lsCases
[ ] TestContactInfo(sItem, hDB)
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[ ]
[ ]
[ ]
[ ] DB_Disconnect(hDB)
[ ]
//-----------------------------------------------------------
[-] testcase TestContactInfo(STRING sTest, HANDLE hDB optional)
[ ] //logic to feed the functions and methods to run the cases and determine pass/fail.
[ ] //can even write results to the same excel file, if need be.
And of course, there are going to be plenty of people out there with var. setups (plans, suites...)
View All Answers

Question - 15:
I would like to verify the title of the new browser window that just popped after clicling link?

Ans:
I am not using any frame file with my scripts.I dynamically get all the links in a web page and click on the link I want to, by matching its caption....The problem I am
facing is that, when I click a link "x" on a webpage it opens a new browser window.I would like to verify the title of the new browser window that just popped after
clicling link "x".Since I am not using frame file I find it difficult to retrive the title of new browser window.....Any solution ?
Ttry with GetCaption ()....
BrowserPage.Getcaption () --> It would return the caption/title of the page...Compare it with the expected value...
Yes, here you have to make sure that the new invoked page gets the attention.....
BrowserPage.SetActive ()
BrowserPage.Getcaption ()
if
the caption is not same as the initial page, this is the new invoked page and what you desire
else
Desktop.TypeKeys ("")
if
if BrowserPage.IsActive ()
get the caption and check as earlier
else
Desktop.TypeKeys ("")
This is just a rough algol, you have to implement it with appropriate loop so that it becomes independent of the number of currently invoked windows....
View All Answers

Question - 16:
How to automate .Net application?

Ans:
How to automate .Net application?
(I am using Silk v7.5 to automating .net application. But most of the control were not recognized by Silk. when I was forcefully mapped with standard Control then
also its not works.)
Try to get .Net Extension... You have to pay separate fee for this Extension.....
View All Answers

Question - 17:
What is the meaning of the Automation framework especially in SilkTest?

Ans:
Automation Framework is a discipline and should have proper design/architecture. You can understand and implement. Automation Framework should have some of
following things.
1. AUT Specific libraries
2. Tool wrapper function libraries.
3. Execution Engine (Script Execution should be drived based on given test data) - Data Driven
4. Results reporting mechanisms (PASS & FAIL for each testcases/procedures and compiled results for all. It would be better, if it captured AUT's snapshots) 5.
Planning for long term automation.
6. Keeping GUI objects info/declarations dynamically or static.
7. Planned approach of unattended execution.
Also framework design differs by tool, scripting languages and type of AUT etc,. Now a days, people are using PERL, PYTHON, TCL/TK for CLI automation. This
design will vary much from GUI specific tool automation's design (QTP, Winrunner, Silktest,Robot and QARun etc).
You can go through following links. Each link is giving different set of components for Automation framework.
Totally Data-Driven Automated Testing http://GlobalGuideline.com/
Test Automation Frameworks http://GlobalGuideline.com/view.php?ID=601
View All Answers

Question - 18:
How can we Increase the virtual memory in Silk Test?

Ans:
I think the licensing admin UI IS java. You can easily check by using Silk itself. (Try enabling Extensions wizard on the license admin UI). As for Silk the chances
are that its MFC, as I have worked with its earlier avataar, Quality Assurance Partner, which itself was there before Java, I believe. That might be the reason it works
best with MFC apps..
View All Answers

Question - 19:
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What is the solution for this?

Ans:
In the application, identify the objects in framefile. Suppose if one the abjects is custom object, you map custom object to standard object. Even after mappiing the
custom object to standard object if the silktest does not idenify the object. What is the solution for this?
First you have to try by enabling various extensions so that the application could be recognized....Even if not possible, the last option is co-ordinates.....but these are
not very much reliable unless done properly.....
View All Answers

Question - 20:
Any ideas how to customize the default recovery system in order to close dialog boxes?

Ans:
Any ideas how to customize the default recovery system in order to close dialog boxes that are parented not to MainWin but to ChildWin would be greatly
appreciated.
The default recovery system only checks those dialogs that are parented to the MainWindow specified in the wMainWindow constant.
the problem is that I want to use any recovery system that will allow me to close dialog boxes that are parented not to MainWin and I need some hints on this (using
dll functions like GetForegroundWindow(), or something else).
Windows NT 4.0 with SP4, and SilkTest 5.0.
Answer1:
Well, this wouldn't be changing the default recovery any, but you could use an appstate that is basedon none rather than basedon DefaultBaseState.
Answer2:
Create a global variable
lwClose = {...}
Windows to close
and add a
TestcaseExist ()
window wClose
for each wClose in lwClose
if wClose.Exists ()
wClose.Close ()
Answer3:
Here's what you do,
In a given tree structure like this:
Win1 Win7
Win2 Win3 Win8 Win9
Win4 Win5 Win6
Notice that Win7 and Win1 have 2 different threads,
Whenever you declare a window: You just add it to the lwClose list.
Here's How: (assuming you just want to keep Win1 open
lwClose = {...}
Win9
Win8
Win7
Win6
Win3
Win5
Win4
Win2
That way you create your tree threads.
Or you can create a fancy Dismiss ()
which does the following:
for i = 1 to ListCount (lwClose)
do
for each wClose in lwClose
wClose.Close ()
except
do nothing (this is incase you cannot close a window before another
Answer4:
I haven't tried this, but, could you create your own ScriptExit or TestcaseExit function that overrides the ScriptExit or DefaultTestcaseExit?
Or could you use the lwLeaveOpen defined in your MainWin and put the dialog name there? Perhaps you could make the variable lwLeaveOpen *not* const and then
in either ScriptExit or TestcaseExit put the dialogs you want to leave open. And/or use the GetNextCloseWindow method to close everything down to the dialog you
want to leave open.
To get a better understanding of how the recovery system works, I suggest you read the defaults.inc file (but I don't recommend editing it; use ScriptExit or
TestcaseExit to override it).
View All Answers

Question - 21:
For a registration purpose I am entering some data?

Ans:
For a registration purpose I am entering some data.. and again for other iterations the testcase going to fail why because...session cookies are still presentand entire
test cases are going to fail .. what I have to do...clearcache is also not working...
Answer1:
We had much of the same kind of issue. The only way around this was to not accept cookies, if the application allowed for it or we killed the browser between tests
and went and deleted the cookie repository directly.
Answer2:
You will have to write a small code that will clean the cache - Browser Tools menu->Internet Options, then Click on Delete Cookies and Delete Files. You can make
this a part of your App state so that it run everytime before you start a test case.
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Question - 22:
How to get contents of a web page? (For Ex: Yahoo homepage)?

Ans:
BrowserPage.SetActive ()
Clipboard.SetText ()
BrowserPage.TypeKeys ("<Ctrl-a>")
BrowserPage.TypeKeys ("<Ctrl-c>")
list of string lsText = Clipboard.GetText ( ) // holds the browser page content
View All Answers

Question - 23:
How can we use more than one browser in silktest. Suppose I want to use three browser how do write script for this case?

Ans:
Use both IE and Netscape simultaneously......you have to make changes in the tag....
View All Answers

Question - 24:
I want to set current path run time?

Ans:
I want to set current path run time - means if I am having scripts on *C:Silktest*XYZ.pln then in Initialise function - I want to set path as
*C:Silktest *
How to do that in ST ?
Also I want to set few run time options , not thr' run time option dialog box but pragmatically Note ::All options present in Runtime dialog
1. Use files
2. Result file path
I checked for .opt file option ..
that is for Agents ONLY I guess..
The "CurrentPath" would return the current path.....Manipulate this string to set your current path......
In .opt file set
[Runtime]
UseFiles=C:SilkTesttest.inc;extendexplorer.inc;so on.........
ResultsPath=C:Silktest
View All Answers

Question - 25:
How to write the single silk statement in two lines?

Ans:
Answer1:
Use Shift+Enter
Answer2:
Very easily found in the online help under:
1) line breaks in code
2) line continuation character
View All Answers

Question - 26:
Does anybody know the escape sequence for space in Silk Test?

Ans:
Does anybody know the escape sequence for 'space' in Silk Test?
For eg :
On the cmd line I have to execute an exe, the location of which is : C:Program Filesxyzabc.exe
Now I need to escape the " " in 'Program Files'.
Answer1:
One thing is, you can use as C:Progr~1xyzabc.exe
Second one is give like myWindow.TypeKeys(" ")
Or just enclose the whole cmd in "". This will handle the space, I think this is your issue?
like:
string sCmdLine = "C:Program Filesxyzabc.exe"
Sys_Execute(sCmdLine)
Answer2:
You can use the command line with quotes when you have a long file name. so, if you need to execute "C:Program FilesMyProgProg.exe"
you can pass the quoted string :
""C:Program FilesMyProgProg.exe""
and it should execute Prog.exe correctly.
Answer3:
Might need to mix your quotes to make that work, like:
"'C:Program FilesMyProgProg.exe'"
View All Answers
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Question - 27:
On the test GUI there is Cancel button and the hot key for that is Alt-c?

Ans:
On the test GUI there is Cancel button and the hot key for that is Alt-c. Alt-c & Alt-C (both lower & upper) should work and manually they are working fine....
Through automation, TypeKeys ("<Alt-c>") is working but TypeKeys ("<Alt-C>") is not working.....
I also tried with
Presskeys ("<CapsLock>")
TypeKeys ("<Alt-c>")
ReleaseKeys ("<CapsLock>")
and
Presskeys ("<Shift>")
TypeKeys ("<Alt-c>")
ReleaseKeys ("<Shift>")
but still no results.....
Any suggestion?
If your application is a standard application and the Keys are well defined, ideally it should work irrespective of ("<Alt-c>") and ("<Alt-C>") , as it seems not your
case , so please try this.
SilkTest provides facilities to incorporate groups of keys that you want pressed simultaneously in the same set of angle brackets, and separate the keys with
hyphens.So Please try this
("<Alt-shift-c>")
neither TypeKeys ("<Alt-shift-c>") nor
TypeKeys ("<Alt-CapsLock-c>") nor
TypeKeys ("<Alt-CapsLockOn-c>") nor
TypeKeys ("<CapsLockOn>")
TypeKeys ("<Alt-c>")
works......
Only TypeKeys ("<Alt-c>") works when CapsLock is off.....if I manually switch on the CapsLock and execute the same statement [TypeKeys ("<Alt-c>")] , it doesn't
work.....
View All Answers

Question - 28:
Has anyone had any experience using the Japanese version of SilkTest?

Ans:
Has anyone had any experience using the Japanese version of SilkTest? We are currently evaluating the need for Japanese SilkTest for testing East Asian software
products. I'd like to find out what specific features the Japanese version of Silk supports that the English version does not.
Segue told us that they did not have a Japanese version of SilkTest. They have a Japanese version of QA Partner 4.0. We tried their internation version of QA Partner
4.0. This supported double-byte characters in the application under test, but the QAP user interface was in English.
View All Answers

Question - 29:
How actually ST works internally from developers point of view?

Ans:
Answer1:
Silk interacts with the GUI to submit operations to the application automatically, i.e., it drives the application.
It consists of two distinct software components:
(i) The Silk host software, and
(ii) The 4Test Agent software.
The host software is the program you use to develop, edit, compile, run, and debug your 4Test scripts & test plans.
The 4Test Agent is the software process that translates the commands in your 4Test scripts into GUI-specific commands. One Agent can run locally on the host
machine, and in a networked environment, any number of Agents can run on remote machines.
Answer2:
Silk - or any compitant GUI auotmation tool works this way:
1. You need to record the GUI of the application .. this is like telling Silk what its goign to work on.
2. Using the recorded GUI of the application, you scrript your test cases,
3. On a new build, you re-execute your test cases.
Any failures are due to :
1. Application error
2. Script error
In case of script error it might be:
1. A logical error,
2. Change in product behavior leading to script error (so the script needs to be updated)
3. OR, the GUI of the application has changed, which means that you need to update the GUI recorded with Silk
When an auotmation tool records the GUI, it basically captures each GUI object along with certain properties of that GUI. These properties are needed to identify the
GUI to the tool the next time automation is run
To give you an example, lets say that on a typically user login page, there are three gui entities:
1. The Username field
2. The password filed
3. The login button
assuming login button has an htm lid=login, silk would record this gui as a HTMLPushButton having the id property = login. (The text caption associated with the
button might be different i.e. "Log in")
Lets say that it was decided to change the caption of this button to "Sign In", leaving the html iid property the same i.e. login. In this case Silk would continue to
playback the GUI automation scripts w/o problem.
BUT in case
In the next buildl, the dev has kept the Button caption same; i.e "Log in" but chnaged the html id of the button to "signin", then Silk WILL NOT recognize the button,
even if for the user (i.e. the person) nothing has changed (he still continues to see a button with text "Log in")
This is the basic principle on which most automation tools work.
Answer3:
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Basically SilkTest has two software
(i) The Silk host software, and
(ii) The 4Test Agent software.
The host software is the program you use to develop, edit, compile, run, and debug your 4Test scripts & test plans.
The 4Test Agent is the software process that translates the commands in your 4Test scripts into GUI-specific commands.
But question arrises how it wors and see or identify object ??
While you record window declarations, SilkTest attempts to identify the class of each object in your GUI and assign the appropriate class from the built-in class
hierarchy. If it is success and belongs to a standard class either MFC or JFC class then objects is idenified. SilkTest contains algorithms to interrogate the objects
based upon the standard libraries. When these algorithms work the object is identified,if not then SilkTest reports the object as a CustomWin. An object is defined by:
Â· Its actual class name
Â· The underlying software code that creates and manipulates it
View All Answers

Question - 30:
How to do negative testing on webpage? Can I have to capture all error pages?

Ans:
Capturing all the error messages page would lengthen your script.....Capture only one page and using "*" in declaration try to make the identifier common to all the
pages...
If the error message appears as a text message, get the index of the text (Generally it is fixed) and retrieve the value of the test and compare with the expected e,g
if BrowserPage.HtmlText ("#1").GetText () == "Invalid date"
Print ("Pass")
else
Print ("Fail")
Suppose first time you enter an invalid mail ID and the error page has the tag "Error Page - Invalid mail ID". 2nd time you enter invalid date and the error page has
the tag "Error Page - Invalid date".
To generalize the error page, change the tag to "Error Page - Invalid*" or "Error Page*" which suffices that error page is there.....
View All Answers

Question - 31:
Html Push button is not recognizing

Ans:
Agent.SetOption (OPT_VERIFY_EXPOSED, TRUE)
Do your click event
Agent.SetOption (OPT_VERIFY_EXPOSED, FALSE)
View All Answers

Question - 32:
How can I access a string from oracle DB?

Ans:
*DB_Connect (con_string)*
View All Answers

Question - 33:
Where is a testplan stored?

Ans:
A SilkTest testplan is stored in a file with .pln file extension.
View All Answers

Question - 34:
How to open an existing SilkTest project?

Ans:
1. Run SilkTest.
   2. Select File menu.
   3. Select Open Project.
   4. Select the project.
   5. Click OK.
   6. SilkTest will open the selected project.
View All Answers

Question - 35:
How to run all test cases in a testplan?

Ans:
1. Open the testplan.
   2. Click Run/Run All Tests menu. SilkTest starts to run all the test cases in the testplan.
   3. Do not touch mouse or keyboard, to avoid interrupting the test case execution.
   4. SilkTest finishes executing the testcase. The Restuls window shows up with the execution result.
   5. Review the execution result.
View All Answers
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Question - 36:
How to run a test case from a testplan file?

Ans:
If a testcase is linked to a testplan, you can run it from the testplan:
   1. Open the testplan.
   2. Select the test description line which has the testcase linked.
   3. Click Run/Testcase menu. The Run Testcase dialog box shows up.
   4. Click the Run button. SilkTest starts to run the test case.
   5. Do not touch mouse or keyboard, to avoid interrupting the test case execution.
   6. SilkTest finishes executing the testcase. The Restuls window shows up with the execution result.
   7. Review the execution result.
View All Answers

Question - 37:
How record a test case into a testplan automatically?

Ans:
Test cases can recorded first without a testplan, then included into a testplan later. Test cases can also be recorded into a testplan directly:
   1. Make sure your testplan is open.
   2. Enter a test descripption into your testplan. For example, "Test change password".
   3. Select this test description.
   4. Click Record/Testcase menu.
   5. Enter a name for the script file.
   6. Click Open. The Record Testcase dialog box shows up.
   7. Enter a testcase name in the Testcase Name field.
   8. Select DefaultBaseState in the Applicatin State dropdown list.
   9. Click Start Recording button.The Record Testcase dialog closes. Your Web application is will be automatically started by SilkTest, based on the information in
test frame file. SilkTest Editor window closes. The Record Status dialog box shows up.
  10. Continue to use your Web application. SilkTest records everything you did on your application.
  11. Click the "Done" button on the Recording Status dialog box to stop recording. The Recording Status dialog box closes. The Record Testcase dialog box shows
up again.
  12. Click Paste to Editor. SilkTest will insert the recorded acitivities as 4Test statements into a script file. The Record Testcase dialog closes.
  13. Click File/Save menu to save the script file. You can enter a script file name. For example, ChangePasswordTest.t.
View All Answers

Question - 38:
How to include a test case into a testplan?

Ans:
1. Make sure your testplan is open.
   2. Enter a test description into your testplan. For example, "Test login process".
   3. Select this test description.
   4. Click Testplan/Detail menu. The Testplan Detail dialog box shows up.
   5. Click the Test Execution tag on the Testplan Detail dialog box.
   6. Click the "Scripts" button to browse and select a test case script file. For example, LoginTest.t.
   7. Click the "Testcases" button, to select a testcase recored in the specified script file.
   8. Click OK to close the Testplan Detail dialog box.
View All Answers

Question - 39:
What are the important aspects of a test case?

Ans:
1. Each test case must be independent of other test cases.
   2. Each test case have a single test purpose.
   3. Each test case should start from a base state and returning to the same base state.
View All Answers

Question - 40:
How to test your DefaultBaseState?

Ans:
1. Close your Web application and other Web browsers.
   2. Make sure your test frame is open.
   3. Click Run/Application State menu. The Run Application State dialog box shows up with a list of states. One of them should be DefaultBaseState.
   4. Select DefaultBaseState.
   5. Click Run button. The Runtime Status dialog box shows up. And the Results File dialog box shows up too.
   6. You should see no error message in the results file.
View All Answers

Question - 41:
How to specify a browser extension to a Web application?

Ans:
1. Run SilkTest.
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   2. Open Internet Explorer (IE).
   3. Enter the URL of the Web application.
   4. Leave the IE window with the Web application. Don't minimize the IE window.
   5. To back to SilkTest window.
   6. Select Basic Workflow bar.
   7. Click Enable Externsions on the Workflow bar.
   8. The Enable Extensions dialog will show up. Your Web application running in the IE window will listed in the dialog box.
   9. Select your Web application and click Select.
  10. The Extension Settings dialog will show up. Click OK to enable the DOM browser extension.
View All Answers

Question - 42:
What is multi-tagging?

Ans:
Multi-tagging is a technique used by the DOM browser extension to identify a Web page UI object. Whenever possible, DOM extension inserts more than one tag
into the object identifier in following format:
   Browser.BrowserChild
   ("page_title").html_class("caption_tag|#index_tag|window_tag")
   1. "caption_tag" is the caption of the HTML element.
   2. "#index_tag" is the index of this HTML element, counting from the beginning of this page of the same class of HTML elements.
   3. "window_tag" is the window identifier.
View All Answers

Question - 43:
How DOM browser extension identify a Web application UI object?

Ans:
A Web application UI object is identified in two parts:
   1. Identify the Web browser window where the Web application is running. For example, a Web browser window can be identified as
"Browser.BrowserChild("Yahoo Home Page")". Another Web browser window can be identified as "Browser.BrowserChild("Google Home Page")".
   2. Identify the Web UI object based on the HTML element that represents the UI object. For example, an image in a Web page can be identified as
"HtmlImage("Yahoo Logo")"; A hyperlink in a Web page can be identified as "HtmlLink("Site Map")"; 
The full identification of a Web applicatin UI object is the concatenation of the browser window identification and the HTML element identification. For example,
the Yahoo logo image is identified as: Browser.BrowserChild("Yahoo Home Page").HtmlImage("Yahoo Logo"). The site map link is identified as:
Browser.BrowserChild("Google Home Page").HtmlLink("Site Map").
View All Answers

Question - 44:
Testing a product with both web and non-web interfaces. testscripts to test both and has had trouble configuring Silk to do this. using Silk 2.1 and is wondering
whether upgrading to Silk 5.0 might help?

Ans:
Trying to automate the testing of both Web GUI and non web GUI at the same time. Meaning in the same testcase?
If not. Organizer: You can create 2 different .opt files (option files) one with the Web environment and the other without. In the organizer Can tell it which opt file to
load before executing a specific testcase.
View All Answers

Question - 45:
Where are the testplan attributes stored?

Ans:
Testplan attributes are stored in the testplan initialization file, testplan.ini, in SilkTest installation directory.
View All Answers

Question - 46:
How to define values for a testplan attribute?

Ans:
You must define values for a testplan before using it:
   1. Make sure your test project is open.
   2. Click Testplan/Define Attributes menu. The Define Attributes dialog box shows up. You should see 3 predefined default attributes and other attributes defined by
yourself.
   3. Select an attribute. For example, "Component". The Values box should be empty.
   4. Enter a value in Add box. For example, "Catalog".
   5. Click Add. Value "Catalog" should be inserted into the Values box.
   6. Repeat the last two steps to add more values.
View All Answers

Question - 47:
Uploaded the image of the application

Ans:
Uploaded the image of the application.Its MS Project Application. In that the marked portion silk recognizes as a ChildWin.
But the statement ChildWin3.SetActive() fails saying that the windowcan not activated. What is the solution ?
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Try with parent window combination: Parent.ChildWin3.setActive()
View All Answers

Question - 48:
How to create group and sub group descriptions in a testplan?

Ans:
In a testplan, each text line starting from column 0 represents a top level group description. To create sub group description:
   1. Move the cursor the next line below the top level group description.
   2. Click Outline/Move Right.
   3. The text line will be indented to the right to be come a sub group description.
View All Answers

Question - 49:
While (FileReadLine (hFile, sMailData)) is not doing it for each line of the input file. How do I tell it to go on to the next line and add each string to the list and add
the list to the master list of list?

Ans:
While (FileReadLine (hFile, sMailData)) is not doing it for each line of the input file. How do I tell it to go on to the next line and add each string to the list and add
the list to the master list of list?
[+] LIST OF LIST OF STRING ParseMailFile ()
[ ] STRING sElement, sLine, sMailData
[ ] HANDLE hFile
[ ] LIST OF STRING lsMailData = {}
[ ] LIST OF LIST OF STRING llsMailData = {}
[ ] rMail Mail
[ ]
[ ] hFile = FileOpen (csDataDir+"Mail.txt", FM_READ)
[-] while (FileReadLine (hFile, sMailData))
[ ] ListAppend(lsMailData, GetField(sMailData, ",", 1))
[ ] ListAppend(lsMailData, GetField(sMailData, ",", 2))
[ ] ListAppend(lsMailData, GetField(sMailData, ",", 3))
[ ] ListAppend(lsMailData, GetField(sMailData, ",", 4))
[ ] ListAppend(lsMailData, GetField(sMailData, ",", 5))
[ ] ListAppend(lsMailData, GetField(sMailData, ",", 6))
[ ] ListAppend(lsMailData, GetField(sMailData, ",", 7))
[ ]
[ ] ListAppend(llsMailData,lsMailData)
[ ]
[ ] FileClose (hFile)
[ ] return llsMailData
[ ]
Just force it to start from first raw before the loop. Should go through each lines.
View All Answers

Question - 50:
What is DBTester?

Ans:
DBTester is a testing tool that allows you to access a database server directly through ODBC drivers. If your application is a database driven application, you can
perform a test through the application UI, and verify data changes in the database with DBTester without using the application UI.
View All Answers

Question - 51:
What is in the test result file?

Ans:
1. Result sumary: The name of the script file. The name of the testcase. The machine on which the tests ran. The starting time and the total elapsed time. The number
and percentage of testcases that passed and failed. The total number of errors and warnings.
   2. Result detail: List of errors and detailed information.
View All Answers

Question - 52:
How to run a test case from a test script file?

Ans:
A test script file can store multiple test cases. You can run a testcase from a test script file:
   1. Open the test script file.
   2. Select the test case in the test file.
   3. Click Run/Testcase menu. The Run Testcase dialog box shows up.
   4. Click the Run button. SilkTest starts to run the test case.
   5. Do not touch mouse or keyboard, to avoid interrupting the test case execution.
   6. SilkTest finishes executing the testcase. The Restuls window shows up with the execution result.
   7. Review the execution result.
View All Answers
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Question - 53:
How to define an object verification in a test case?

Ans:
While recording a test case, you can define verification points to verify UI objects:
   1. Make sure you are in the process of recording a testcase.
   2. Make sure the Record Status dialog box is on the screen.
   3. Make sure your recording reached the Web page that has the UI object you want to verify.
   4. Click the background (blank area) of the Web page. Do not click any objects on the page.
   5. Press Ctrl-Alt. The Verify Window dialog box shows up. All the objects on the current Web page are listed on the Verify Window dialog box.
   6. Select the object to be verified in the object list. Un-select all other objets.
   7. Select the property to be verified in the property list. Un-select all other properties.
   8. Click OK to close the Verify Window dialog box.
   9. Continue your recording.
View All Answers

Question - 54:
How to hide all the comments from a script if required?

Ans:
How to hide all the comments from a script if required? [ want to hide them when printing but still see them in the editor? want to hide them when copying]
This can't be done. You may want to contact Segue to add it as a future enhancement.
View All Answers

Question - 55:
What is the standard flow of execution of a test case?

Ans:
1. Starting from the base state.
   2. Drive the application to the state where the expected result should occur.
   3. Verify the actual result against the expected result.
   4. Declare the test case as passed or failed.
   5. Return to the base state.
View All Answers

Question - 56:
What is DefaultBaseState?

Ans:
The DefaultBaseState is a starting point of test project from which the Recovery System can automatically restart your test cases when test cases fail to continue.
View All Answers

Question - 57:
Problem in calling DLL functions.

Ans:
[I have a DLL which contains simple functions
function1 is just returning a char value
function2 returns a Long value
function3 returns a int value
function4 returns a double value
function5 returns a float value
but when I assign a 4test variable by calling all above functions or printing the returned value it creates a problem.
Problem:
1. Not able to return the correct "char" value from dll function. it gives garbage. same problem is with function returning float . working fine for the function
returning int,double.DLL is loaded properly. Using "SilkTest 6.5 International", windows-xp. Dll was created in .NET framework . Also the functions are wrapped
into "C" wrapper
Above all function gives correct values when call in a .NET framework.]
Used proper SilkTest DataType ie. String corresponding to C Char type But this time Agents crashes giving error *** Error: The Agent has abnormally exited when
Aborted and silk test hangs on the statement calling Dll function returning char .
Please see the sample code
[+] dll "C:partnerTEST70FrameXPressVishnu1.dll"
[ ] String ReturnChar()
[ ] float ReturnFloat()
[ ] double ReturnDouble()
[ ] long ReturnLong()
[ ] int ReturnInt()
[+] testcase DllTest()
[ String str=ReturnChar()
// hangs for ever at above statement and agent crashes
[ ] Print(ReturnInt())
[ ] Print(ReturnChar())
[ ] Print(ReturnFloat())
[ ] Print(ReturnDouble())
[ ] Print(ReturnLong())
in Dll definition of ReturnChar()
Char ReturnChar()
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{
Char a='h' ;
return a;
}
View All Answers

Question - 58:
I am facing a strange problem in which Agent hangs only while executing my script for the first time

Ans:
I am facing a strange problem in which Agent hangs only while executing my script for the first time.
Scenario:
1. It launches the website and Clicks to download the product.
2. By the time product is downloaded in some temp. folder, Silk is waiting for installation clause is there for install window)
3. Now, as soon as this install window comes up Agent hangs(Waitforwindow clause gets stuck in Status window)
Now, I kill my application install window, stop silk. Reexecute steps 1,2,3 they all go fine.
Question:
Any ideas, what causes Agent to hang during first time execution?
Answer1:
This problem is coming because Silk agent is unable to recognise that window first time.
Try with window.exists(). If window exists then only perform remaining operations.
Answer2:
I dont think this solution(Window.Exists ()) will work out for you.
This is a bug in Silk 6.5 and resolved in Silk 7.1.0.3, If possible upgrade your Silk.
View All Answers

Question - 59:
How to create a test frame?

Ans:
1. Make sure your Web browser is active and showing your Web application home page. Do not minimize this Web page window.
   2. Make sure your test project is open.
   3. Click File/New menu. The New dialog box shows up.
   4. Select the Test Frame radio button.
   5. Click OK. The New Test Frame dialog box shows up with a list all active Web applications.
   6. Select your Web application.
   7. Enter a test frame name. For example: HomeFrame.inc.
   8. Review the window name. It should be the HTML title your Web application. You can rename it, if needed.
   9. Click OK to close the New Test Frame dialog box.
  10. Click File/Save menu.
View All Answers

Question - 60:
How to assign attribute values to test cases?

Ans:
1. Make sure your testplan is open.
   2. Click on the test case for which you want to assign an attribute value.
   3. Click Testplan/Detail menu. The Testplan Details dialog box shows up.
   4. Click the Test Attribute tab.
   5. Click the Component field. The dropdown list shows up with all values of "Component".
   6. Select one of the values in the dropdown list.
   7. Click OK.
View All Answers

Question - 61:
When invoking the java application there the application is getting invoked

Ans:
When invoking the java application there the application is getting invoked (that is silk test is able to start my java apllication) and then comes login screen but silk
Test is giving error JavaMainWin not found.
Why ? it is not coming out of invoke and excuting other part of code like entering username & password to login in that application.
Answer1:
After Invoking the application, Silk waits till it can find the application...In this case the application is your java window....
Sometime it happens that after invoking, silk is unable to recognize but if you invoke manually it works fine...
Solution:
Declare a window variable and use start method.
Now you might using the code
JavaAppWindow.Invoke ()
Instead of this do the following
Window MyJavaApp
MyJavaApp.Start ("path of exe or batch file to invoke the application")
sleep (x) (x --> appropriate value)
Answer2:
window MainWin MyWin // declare as global
main ()
try ()
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testcase try () appstate none
MyWin.Start(sPath)
Answer3:
When you give start command as a part of JavaMainWin, ensure that your class path is running independantly - outside the Silk. It should work fine from
JavaMainWin as well.
View All Answers

Question - 62:
How to define new testplan attributes?

Ans:
1. Make sure your test project is open.
   2. Click Testplan/Define Attributes menu. The Define Attributes dialog box shows up. You should see 3 predefined default attributes: Category, Component, and
Developer.
   3. Click the New button. The New Attribute dialog box shows up.
   4. Enter a name for your new attribute. For example: "Level" to indicate the complexity level of test cases.
   5. Select an attribute type: Normal, Edit, or Set.
   6. Click OK.
View All Answers

Question - 63:
What are the default testplan attributes?

Ans:
SilkTest offers you 3 predefined default attributes:
   1. Category: The type of testcase or group of testcases. For example, you can use this attributes to categorize your test groups as "Boundary value tests",
"Navagation tests", etc.
   2. Component: The name of the application modules to be tested.
   3. Developer: The name of the QA engineer assigned to develop the testcase or group of testcases.
View All Answers

Question - 64:
How can I get password in SilkTest?

Ans:
[I have one web page after filling the information I will get a password to the respective user maild id provided in the registration page...if I want continue next
scenario that password is needed.... how can I follow... the steps... I have to take that password from database itself.. or what else...]
If it's a good database schema, the database will be encrypted so that won't work. You will have to query the mail server and retrieve the information from there
instead.
telnet mailserver 110
user {mailUserName}
pass {mailUserPassword}
retr 1
// this assumes that there's only one message there dele 1
View All Answers

Question - 65:
How to create and edit a testplan?

Ans:
1. Make sure your project is open.
   2. Click the Files tab in the Project Explorer.
   3. Right-click the Plan folder.
   4. Click New File.
   5. An untitled testplan file opens in the SilkTest testplan editor.
   6. Click File/Save menu to save the testplan.
View All Answers

Question - 66:
SilkTest vs. Visual Test?

Ans:
It really depends on what you are testing. For complex web sites (pages not static, multiple browser windows, JavaScript), I would say SilkTest works much better.
In general, Visual Test is new to the web browser game. If it is a Win32 app that you are testing, VT is *much* faster than Silk and the code compiles down to a
binary file that can easily be put on diffrent test systems. This is a *big* plus for Visual Test.
SilkTest will make the declaration file for you, so this saves allot of time. In VT, you have to make the declarations yourself, but if the product isn't huge, this isn't a
big deal.
SilkTest also is great a capturing text on a page (either web or Win32 based). VT, last I checked, lacked this function. It is a useful function for verification.
SilkTest also has a nice verification function that it makes (a few keystokes and it's done). Real easy to change some of the hardcoded data here with data from a text
file or other place. Nice for doing report verification where the layout is the same, but the data is diffrent.
Cost is another big issue. SilkTest is low in price, Silk quite high.
So, again, it depends on your needs, what and how you will be testing it.
View All Answers

Question - 67:
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For automating a web based application using JSP

Ans:
For automating a web based application using JSP, there is a search textbox, a "Search" button, a listbox, a "OK" button, and a "Cancel" button. The "OK" button
remains disabled by default. I need to enter a value in search textbox, click on search button, select the resultant value in the listbox and then the "OK" button is
enabled.
Problem: When all this is automated, Silktest finds the OK button still disabled after selecting the resultant value, though the button is enabled.
Put one statement before clicking on save button
BrowserPage.flushcache()
View All Answers

Question - 68:
Runtime Error in Silk?

Ans:
It may be programming error, since DB next is used to go the next data in the table , may be it is getting to the last value, and not getting any value there.
View All Answers

Question - 69:
My requiremtn is to click a link in the web based application?

Ans:
My requiremtn is to click a link in the web based application.I have written a method to click the Java Script link.but it is giving the Window is not exposed Error.
I tried to solve with the following silk options .
[ ] Agent.SetOption(OPT_VERIFY_EXPOSED, FALSE)
[ ] window.ClearForm.SetFocus()
[ ] window.ClickClearForm()
[ ] Agent.SetOption(OPT_VERIFY_EXPOSED, TRUE)
It is giving the same error.
try the following code
[ ] Agent.SetOption(OPT_VERIFY_EXPOSED, FALSE)
[ ] Agent.SetOption(OPT_VERIFY_ENABLED, FALSE)
[ ] window.ClearForm.SetFocus()
[ ] window.ClickClearForm()
[ ] Agent.SetOption(OPT_VERIFY_ENABLED, TRUE)
[ ] Agent.SetOption(OPT_VERIFY_EXPOSED, TRUE)
View All Answers

Question - 70:
Can we integrate Silk Test with Quality Centre?

Ans:
Silk cannot be integrated with Quality centre.
View All Answers

Question - 71:
How do I declare the tag, so that SilkTest recognizes only the beginnig of the text?

Ans:
1. Try to declare the tag with prior text.
2. Try to declare the tag with location ... meaning #3 (This mean that this is the 3rd dynamic text in the page).
3. You can try to GetText ()
Note: As you know you can declare a tag in 5 different ways:
example:
Prior text : ^Foo
Location (relative to the page): #3
The exact text: (And you don't need to do this if the text is changing all the time)
Location (co-ordinates): and again this is not a good one to use.
View All Answers

Question - 72:
what if the object is dynamically changing. How does silktest identifies the object?

Ans:
1. if you are talking about webpages, you can use BrowserPage.FlushCache( ) method.
2. You can use multitag concept
View All Answers

Question - 73:
How to change the absolute paths to relative paths?

Ans:
Need to use the relative paths in my SilkTest Project. How to change the absolute paths to relative paths? (Note:The purpose is that, when package the project, that
package can be used on any other machine, irrespective of the paths defined, it should run on that machine too.)
Silk Projectoffers you some out of the box solution for this. If your suite is not implemented as a project, the best option is to use relative path in the Runtime options
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dialogbox, with the Root of the suite hardcoded.
i.e. Use Path = S:Suite << S maps to root of the automation suite
and use files are relative .i.e. frame.inc, ..configconfig.inc etc etc,
View All Answers

Question - 74:
How to down load latest silk test trial version?

Ans:
You don't as there are no free downloadable SilkTest trial versions. You must contact Segue sales and they will set you up with an account after you can demonstrate
both need and desire to purchase, or at least evaluate. You then download SilkTest using that account.
View All Answers

Question - 75:
I am trying to run a remote application in Windows 2003. But everytime time I am getting the following error:

Ans:
I'm trying to run a remote application in Windows 2003. But everytime time I'm getting the following error:
"*** Error: Bad channel to agent call" .
My host and agent machine is running on Windows 2003. I have changed the network option for both Host and Agent machine as TCP/IP and port no 2965. Along
with that, I have also changed the Agent Name in the Runtime options by Agent machine IP address and network as TCP/IP. Along with that I have also enabled all
the relevent extensions.
If any one can let me know whether I have missed out anything in the configuration or do I need to do something else also. Also has any one came accross this kind
of error (marked in red) previously.
Trying to use remote recording and play facility provided by Silk, for the same, agentname/ipaddress of the system, where remote agent needs to be used, should be
entrered in the host machine's runtime options.
Use Connect () to connect to the target machine....After you connect to the target, then you don't need the agent at m/c where host is installed....So at host place, agent
is local or any thing else doesn't matter....If you don't use Connect (), then you have to mention the remote agent name at the host runtime option...[I think so but I
haven't tried this]....Now let us come to remote machine....Here even if you don't have the host installed (only Agent installed) your script would run....The host at
remote machine is not used and therefore the settings made on the remote host are irrelevant...Only remote agent is used for interaction and the network should be
enabled at remote agent...
If you use "local" in agent-options, recording and playback would be done locally i.e silk host would use local agent to do this thing. But if you use "ipaddress:port",
the same would instruct silk-host to use remote agent for record and playback..or simply any activity.
Here is a sample code which runs successfully invokes the notepad at remote m/c [192.168.240.102 <http://192.168.240.102> ] and closes it
[ ] const wMainWindow = Notepad
[ ]
[-] window MainWin Notepad
[ ] tag "*Notepad*"
[ ]
[ ] const sCmdLine = "C:WINNTsystem32NOTEPAD.EXE"
[ ]
[-] main ()
[ ]
[ ] Connect ("192.168.240.102 ")
[ ]
[ ] Notepad.Invoke ()
[ ] Sleep (2)
[ ]
[-] if Notepad.Exists ()
[ ] Print ("Notepad invoked at remote")
[ ] Notepad.SetActive ()
[ ] Notepad.TypeKeys ("<Alt-F4>")
[ ] Sleep (2)
[-] else
[ ] LogError ("Notepad not invoked")
View All Answers

Question - 76:
Need to use the relative paths in my SilkTest Project. How to change the absolute paths to relative paths?

Ans:
Need to use the relative paths in my SilkTest Project. How to change the absolute paths to relative paths. The purpose is that, when package the project, that package
can be used on any other machine, irrespective of the paths defined, it should run on that machine too.
Answer1:
Say you have following organization of files
C:TestScriptScript.t
C:TestWDecWDec.inc
Now in Scrpt.t file to include WDec.inc, code following
1. use " C:TestWDecWDec.inc" --> Absolute
OR
2. use "..WDecWDec.inc" --> Relative [Move one level up from Script folder, then go to WDec folder]
Answer2:
I think if you work with Silk Project, it offers you some out of the box solution for this. If your suite is not implemented as a project, the best option is to use relative
path in the Runtime options dialogbox, with the Root of the suite hardcoded.
i.e. Use Path = S:Suite << S maps to root of the automation suite
and use files are relative .i.e. frame.inc, ..configconfig.inc etc etc,
View All Answers
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Question - 77:
When I try to enable extensions for my browser i.e. IE, the following error occurs?

Ans:
When I try to enable extensions for my browser i.e. IE, the following error occurs,
"Can't load helper qaphlpr.dll: The specified module could not be found."
My question is, does this mean that the SilkTest needs to be installed again or if there is any workaround.
Check whether the required dll is in the silk test installation folder.
View All Answers

Question - 78:
Is there a way to handle this type of issue?

Ans:
When click a link the new page(either same browser window or new) that opens doesnot load completely...meaning...the progress bar would stop to progress as
shown in the attachment.....Finally the application would timeout after 180 seconds.
One work around for this is to increase the application timeout and wait longer. Can someone suggest a better workaround? Is there a way to handle this type of
issue...
Try with browser.StopLoading ( ).....The method works by clicking the Stop button on the tool bar. When the browser is not responding(progress bar stops moving),
use a Browser.ForceReady(True) to interact with the Browser and after performign necessary actions(In our case browser.StopLoading ( )..) use
Browser.ForceReady(False)
View All Answers

Question - 79:
How to retrieve the decimal part of value stored in float variable. Also how to retrieve the Integer part? Is there a function?

Ans:
the snippet code for the prob.
[ ] real rVal1=89.822 // Assume your real number is rVal1
[ ] integer iValue = [int]rVal1
[ ] real rVal2= rVal1-iValue
[ ] print(iValue) // Integer part of u r number
[ ] print(rVal2) // Decimal part of u r number
View All Answers

Question - 80:
Can anybody explain me, where does logs get stored for an activity performed in Silktest?

Ans:
Answer1:
Following command will export the log in text format.
"c:program filesseguesilktestpartner.exe" -complog "c:logs.txt"
-resextract -r "C:sample.pln"
Answer2:
By default, Silk doesn't create log files, it create a .res files. They are binary files and .log giles are usually text files.
However if you call partner.exe from the command line with the -resextract it will create a copy of the .res file as .txt.
These files are created in the directory where the .t file or .pln file that is executed are located.
View All Answers

Question - 81:
How to hide Password in the script file?

Ans:
In Winrunner, the password is recorded in the encrypted form but in Silk it is recorded as it is.....
Can't be done right within the script, but if you want to make a work around, you could read it in from a file.
If that's not good enough (the password would be stored in the file in plain text too), you could use a tool to encrypt the password and use that tool to decrypt it. You
could then make a call to an external language (Ruby, Perl, Python, etc.) to do the heavy work of encrypting and decrypting the information and pass that through as a
variable.
The problem is that whatever method you use to enter the password unencrypted into the login screen can also be used to just write it to a file.
Don't use your own account. Use a dummy, testing account.
View All Answers

Question - 82:
How to sort List of List of String?

Ans:
[+] testcase test() appstate none
[ ]
[ ] LIST OF LIST OF STRING llsStr =
{{"1234","A"},{"2242","B"},{"2234","C"}}
[ ] Print(Sort(llsStr))
[+] LIST OF LIST OF STRING Sort (LIST OF LIST OF STRING llsStr)
[ ]
[ ] LIST OF STRING lsStr
[ ] INTEGER i, j , k
[ ] k = ListCount(llsStr)
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[+] for (i=1;i <= k;i++)
[+] for (j=i+1; j<=k; j++)
[+] if val(llsStr[i][1]) > val (llsStr[j][1])
[ ] lsStr = llsStr[j]
[ ] llsStr[j] = llsStr[i]
[ ] llsStr[i] = lsStr
[ ]
[ ]
[ ] return llsStr
View All Answers

Question - 83:
I want to remove printing of this script of the test case in result window. How can I do this?

Ans:
In the Result Window page once after case is passed, along with the Results what I am printing, script inside the test case is also printing line by line.
I want to remove printing of this script of the test case in result window. How can I do this?
Answer1:
In Option --^gt; Runtime dialogue Box, at the result section there are several check boxes....Depending on your selection result is generated..... Check/Uncheck the
boxes as per your need.....
To be more specific; In Option -> Runtime dialog ; uncheck 'Print agent calls' and 'Print tags with agent calls' under the head 'Debugging'
Answer1:
Execute the test plan:
"C:Program FilesSegueSilkTestpartner.exe" -q -resextract -r
"C:BVTBuild Verification Test.pln"
This creates a binary results file called Build Verification Test.res and a text results file Build Verification Test.txt.
Then from the batch file that called the script I make a call to head head -n1 "c:BVTBuild Verification Test.txt" > "c:BVTBuild Verification Test Summary.txt"
That gets me the first line, (Pass/Fail) I could make the -n switch larger to get all of the elements.
I then use a product called blat to e-mail that summary to my inbox along with the entire results as an attachment.
This way I don't have to print the results at all.
The version of head I use is part of cygwin. Here's where you get blat http://www.blat.net/
Note: What is Blat?
Blat is a Win32 command line utility that sends eMail using SMTP or post to usenet using NNTP.
View All Answers

Question - 84:
How to access script from other machine?

Ans:
Share the folder containing the script......very simple.... You can run the script from your machine and target may be some other machine using connect ()... But
somebody else cannot access unless you share or try other options...
View All Answers

Question - 85:
Expain about data driven testing using silktest

Ans:
1) Create an .xls containing the data required in the script such as username and password for this example
2) In Silk select Workflow -> Data Driven
3) Select Data Driven Test Case (after you create your testcase) Following the wizard browsing to the .xls file containing your data when prompted. This creates the
DSN automatically for you. Accept rest of defaults barring you required naming conventions
4) In you script then code your method as say for example:
[CODE]
testcase DataDrivenExample () appstate DefaultBaseState
[ ]
[ ] Browser.Maximize()
[ ]
[ ] // If the Logon page is not displayed Load it.
[-] if (!LoginPage.Exists())
[ ] Browser.LoadPage("{kProtocol}://{kWebServer}:{kPort}/logon.jsp")
[ ]
[ ] LoginPage.LoginUser (User, Password)
[ ] ApplicationHome.Exists(kPageTimeOut)
[ ] ApplicationHome.SetActive()
[CODE}
Now highlight your variable User say first and from the column drop down list on the replace pan select your UserName column(that is been linked to your
spreadsheet, this is all automatically done) and select Replace button, do the same for the rest of your required data. Notice the DATA DRIVEN ASSISTANT
SECTION is automatically generatign code. This is a good way to start off anyways, hope it's been of some help, simple xls sheet attached but only expremely basic
one
Below is what Code migth look like after Replace is selcted
[CODE]
testcase DataDrivenExample (REC_DATALIST_DD_DataDrivenExample rData) appstate DefaultBaseState
[ ]
[ ] Browser.Maximize()
[ ]
[ ] // If the Logon page is not displayed Load it.
[-] if (!LoginPage.Exists())
[ ] Browser.LoadPage("{kProtocol}://{kWebServer}:{kPort/logon.jsp")
[ ]
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[ ] LoginPage.LoginUser (rData.recSheet1_.User, rData.recSheet1_.Password)
[ ] ApplicationHome.Exists(kPageTimeOut)
[ ] ApplicationHome.SetActive()
[CODE]
View All Answers

Question - 86:
What .OPT file is used for?

Ans:
.opt file is used to set the options.......
Say in your script you set the option
Agent.SetOption (OPT_WINDOW_TIMEOUT, 5)
Agent.SetOption (OPT_WINDOW_RETRY, 0.06)
Agent.SetOption (OPT_KEYBOARD_DELAY, 0.3)
.....
.....
For few options you can set in your script.....If you are going to set more number of options, it is better to set in an .opt file and use that .opt file....
The above example is for Agent option....There are other options e,g General, Runtime etc which you have to set in the .opt file
View All Answers

Question - 87:
What is about .vtp file in silktest?

Ans:
.vtp files are project files.....help tells extensively on it.
View All Answers

Question - 88:
I want to select sub menu -< what shuld I use ?

Ans:
I am using function PopupSelect() for selecting popup menu item. But it selects main menu only .
I want to select sub menu -< what shuld I use ?
Ex
Window.PopupSelect(xPos, yPos, "File")
and now File menu contains sub menu lets say "NEW" How can I select that ?
Here I am using PopupSelect Function for TreeView.
*************************************************************
Here suppose I want to Select "New" Submenu from File Main Menu
use "/" character for submenu.
"#" character is used only when u passed SubMenu Index
*************************************************************
// For SubMenu Menu
sMenu = "File/New"
Window.PopupSelect(x,y,sMenu)
// For SubMenu Index
sMenu = "File/#1"
Window.PopupSelect(x,y,sMenu)
View All Answers

Question - 89:
How to read .xls file contents without using the ddt wizard?

Ans:
How to read .xls file contents without using the ddt wizard? [the result file is result.res Parsed it to result.rex file such that I can read this file The test case file is
testcase.xls
Now I need to search the contents of that file and next to the cell I need to update the result of the rex file
I succeeded to read a .rex file
Now I need to know is there any simple way to read the xls file and need to update this file
I tried with one approach and further i strucked
[ ] STRING gsDSNConnect = "DSN=Segue DDA Excel;DBQ=C:abcdef.xls;UID=;PWD="
[ ] HDATABASE DBHandle
[ ] HSQL SQLHandle
[ ] DBHandle=DB_Connect(gsDSNConnect)
[ ]
[ ] SQLHandle=DB_ExecuteSql(DBHandle,"select ")
From here on wards I didn't got the idea how to read the contents of .xls file)
[-] List of anytype ReadingDataFromXLS(string sFileName,inout anytype aRecordName, string sQuery optional)
[ ]
[ ] List of anytype lrRecordData
[ ]
[ ] HDATABASE hdbc
[ ] HSQL hstmnt
[ ]
[ ] string sFilePath = "{sFileName}.xls"
[-] do

Copyright © https://InterviewQuestionsAnswers.org Page 22/36

https://interviewquestionsanswers.org/
https://interviewquestionsanswers.org/_SilkTest
https://interviewquestionsanswers.org/__Expain-about-data-driven-testing-using-silktest
https://interviewquestionsanswers.org/__What-OPT-file-is-used-for
https://interviewquestionsanswers.org/__What-is-about-vtp-file-in-silktest
https://interviewquestionsanswers.org/__I-want-to-select-sub-menu-what-shuld-I-use-
https://interviewquestionsanswers.org/


SilkTest Interview Questions And Answers

Interview Questions Answers.ORG

[ ]
[-] if (!SYS_FileExists(sFilePath))
[ ] Log.Write("File does not exists in specified path i.e {sFilePath}, Please check the existance of the file.","ERROR")
[-] else
[ ]
[ ] // connect to xls file
[ ] hdbc = DB_Connect ("DSN=Segue DDA Excel;DBQ={sFilePath}")
[ ]
[-] if (sQuery != NULL)
[ ] // retrieve info from Excel worksheet
[ ] hstmnt = DB_ExecuteSql (hdbc, sQuery)
[-] else
[ ] // retrieve info from Excel worksheet
[ ] hstmnt = DB_ExecuteSql (hdbc, "SELECT * FROM `Sheet1$`")
[ ]
[ ] //Loop through excel file for retriving the data
[-] while (DB_FetchNext (hstmnt, aRecordName))
[ ] ListAppend(lrRecordData,aRecordName)
[ ]
[ ] //release SQL stmt resources
[ ] DB_FinishSQL (hstmnt)
[ ]
[ ] // Disconnect
[ ] DB_Disconnect (hdbc)
[ ]
[ ] //return the excel data in record structure
[ ] return lrRecordData
[ ]
[-] except
[ ] Log.Write("There may be problem in reading the excel file.. Please close all opened Excel files","ERROR")
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Question - 90:
Need to get file size for a file present on Unix machine , thr silktest at run time. How to get it ?

Ans:
Answer1:
SilkBean is used for working in unix...I haven't used it....See help...the steps for silk bean settings are mentioned there....
Otherwise, considering telnet window (whatever used for connection) as a DialogBox, automate the steps using TypeKeys()..
Answer2:
I guess SilkBean can be used ONLY with Java based applications :-?
I saw help in ST help .... as it looks too much .. for my simple task of getting a *file size *of one of the file on Unix machine ...
I would like to know the WAYs i can get file size OR properties of a file on Unix machine through ST ?
Anyways , but SilkBean looks nice solution for same ..
also how can i execute some application thr' ST ? lets say cmd prompt < * cmd.exe >*
Answer3:
Use SYS_Execute ("C:/Vaibhav/xyz.exe") if xyz.exe is lying at C:/Vaibhav
For standard commands there is no need to separately invoke Dos Command Prompt.....
e,g SYS_Execute ("echo %USERNAME%", lsOutput) would return the user name in the lsOutput variable...
Answer4:
How would you do this if you were running the test manually?
I suspect that you would open a terminal application and perform an ls -l You might also pass that through grep or awk.
We use cygwin under windows to perform bash shell scripts here so here's what I would do
You may need to create a system variable for your path to cygwin binaries or one directly to bash.exe, but if you install it normally, the bin directory will be exposed
to the command line environment.
ls -l //servernamepathfilename | gawk '{print $(6)}'
encase that in a SYS_Execute () and parse the results
[ ] INTEGER iFileSize = SYS_Execute ("ls -l //servernamepathfilename | gawk '{print $(6)}'",lsSysResult)
You're set.
I haven't tried this, but it should work.
Answer5:
If its only a file size u need, and need to get it from a telnet session, read on....
putty is a windows client with which one can connect to a Unix/Lx m/c using standard telnet or ssh. Its easy to automate this UI on windows. If you enable logging to
a file (the file saved on the windows client), all the telnet session is captured to this file. One can then get the file size or whatever the results of the commands run on
the unix m/c over telnet. Even easier is the Hyper Terminal Program which comes with Windows.
Both PUTTY and HTERM give you a Windows UI and not the cmd prompt, which some people may find hard to automate
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Question - 91:
Getting following error on selecting an item from a ListBox?

Ans:
Getting following error on selecting an item from a ListBox (JavaJFCListBox)
[ ] *** Error: Control is not responding
[ ] Occurred in Select
[ ] Called from LetterEditTool at FabEditorScript.t(1060)
Sometimes it works fine.....
Any suggestion?
This is a catch-all error message. It usually occurs in a Select( ) statement when SilkTest is trying to select an item from a ListBox, TreeView ListView, etc.
Set the following option just before the line causing the error: Agent.SetOption(OPT_VERIFY_RESPONDING, FALSE)
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Question - 92:
I ca not simple use DialogBox ( ).Close () from some reason it is not working?

Ans:
I have a button that upon clicking on, pops a second BrowserChild. This window however does not have the usual toolbar. It is actually generated by a javascript
function (openWindow). How do I close that window. I can't simple use "DialogBox (" ").Close ()" from some reason it is not working.
The trully depends on how the second window is declaried.
I work with browsers that have popup windows (using JavaScript) that contains no Browser characterists (no toolbar, status bar, location, etc). So, Silk views the
browser as a dialog, but declaring it as a dialog, it fails. It also see's a browser inside. So, I let Silk declare it as a dialog and typically get something like:
[code]
[-] window DialogBox DBCreateOffer
[ ] tag "Requisition Create?Edit"
[-] window BrowserChild BCCreateOffer
[ ] tag "Create Offer"
[ ] parent "CustomBrowser"
[/code]
I then modify the declaration that Silk made and make the BrowserChild part of the dialog:
[code]
[-] window DialogBox DBCreateOffer
[ ] tag "Requisition Create?Edit *"
[-] BrowserChild BCCreateOffer
[ ] tag "Create Offer"
[/code]
I can then close the browser "dialog" by calling:
DBCreateOffer.Close()
View All Answers

Question - 93:
Need help regd. silk test runing thr .bat file on cmd prompt?

Ans:
<Plan File path> - Enter Plan File Path - e.q - c:test
<Plan File Name> - Plan File Name - e.q - sample.pln
syntax :
"C:Program FilesSegueSilkTestpartner.exe" -r "<Plan File path><Plan File Name>.pln"
e.q
"C:Program FilesSegueSilkTestpartner.exe" -r "c:testsample.pln"
Copy above line in .Bat file or run this line in Command Prompt.
View All Answers

Question - 94:
How can I access empty string from excel sheet?

Ans:
customize code like this
Solution1:
==========
[-] if sText!=NULL
[ ] Page.tfldName.SetText(sText) // do the operation
[-] else
[ ] Page.tfldName.CleartText()
Permanent solution: Add the below winclass to your code(if it is web application simply paste it, else make HtmlTextField as TextField), Now Text field will not
raise exception on null value.
[-] winclass HtmlTextField: HtmlTextField
[ ]
[-] void SetText(String sText optional)
[+] if sText==NULL
[ ] this.ClearText()
[+] else
[ ] derived::SetText(sText)
View All Answers

Question - 95:
Sessionids problem

Ans:
[I am running a script on a webbased application...so many use cases are there in my excel sheet....once the checking for the errors I have to go through next
iteration...but sessionids are still present in the browser and disturbing entire process.. what can I do through script itself I am clearing temp internet
files,deletecookies etc.. even though I am getting problem ]
To go to next iteration (login) you make sure you logout for the previous login....
Before login, use ClearCache () and see whether it works or not....
View All Answers

Question - 96:
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Is this correct behavior for Silk or one of the idiosyncrasies of my non-standard windows?

Ans:
When I extended the delay I noticed that Silk is a bit bizarre in the way it selects a sub menu item. For example, if you're selecting the first sub menu off the first
menu item Silk drops down the menu, highlights the last item then back to the top and finally selects the sub item. Is this correct behavior for Silk or one of the
idiosyncrasies of my non-standard windows app?
Answer1:
If I recall correctly, this behavior is a symptom of having changed the "Events used to invoke popup menus" string in the Agent Options/Other tab. Its default value is
set to an unintuitive "<Button 2><Up><Down>". However, if you change it to "<Button 2><Down><Up>" it will perform as you describe.
Answer2:
If you select Options->Agent, then select the "Other" tab, you'll see a couple of checkboxes: "Pick menus before getting menu item information" and "Pick
dropdowns before getting menu item information". I'm guessing that you have these checked by the behaviour you are describing. If you uncheck them, Silk won't
check all of the menuitems before it does the Pick().
View All Answers

Question - 97:
How does Silk do with People Soft applications?

Ans:
Two questionsfor Web and Application testing (People Soft)
[(1) Can Silk concurently drive BOTH a web application and a People Soft Application. Assuming I do not use appstates.
(2) How does Silk do with People Soft applications. Anyone out there have any war stories (good and bad) about this? I know people soft employs SQA and only
SQA for this type of testing.
(3) When I do record the few People soft apps (for subsequent programming of tests) the recording is very slow. Also there are frequent agent freeze ups during a
record session. The only way around this has been to reboot my machine.
I do not have any specific knowledge of People Soft applications but if you can see object with the recorder there should not be to many differences to other mixed
application test scripts.
1) Yes Silk can drive both a web application and another application(such as People Soft)
I would recommend creating frames in separate *.inc files and then commenting out the const wMainWindow variable on the secondary application (I suggest the
People Soft app as you can then use the default browser settings to assist in setting default states). The wMainWindow indicates what application to use for base
states. This allows you to use application states if you need to. You can modify the default state to also start up the People Soft application. I have written scripts to
manage browsers and FTP clients. This was quite successfull. The FTP clients were not web based (CuteFTP).
2) I don't know the specifics about this one. If you can automatically identify all of your object or Class map them effectively there should not be any large problems
with using Silk with People Soft Applications. Our company has its own product called OpenUI for GUI design and Silk performs fine with it. We map our
OuiFrames to VBFrames and the remainder of the objects are identified correctly. We have had a couple of strange things (tags altering) but nothing that could not be
identified and worked around. We have quite a large suit of test cases. If you can record the object on the screen and they are identified as Text fields, Windows,
buttons etc correctly you should not experience any large problems using Silk with People Soft products.
3) The recorder freezing up is quite common for everyone (at least everyone I know). If you are on NT you should only have to log out and back in again. If on Win
95/98, yes you will need to reboot. It is a real pain. I am getting nervouse about demonstrating the recorder to prospective customers. The good news is that Segue is
addressing this issue with the recorder as we speak so I assume it should be resolved in future releases. (I am not from Segue so this is not an official statement, just
heared it on the grapevine.) The speed of the recorder should not be a long term problem as these types of tools are really not good past the inital development stages.
The are too limited and dont structure the code correctly. I have had problems with speed particulary associated with the freezing. It seems to slow down to about one
micro instruction a second which is very frustrating.
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Question - 98:
How to select a group of test cases in a testplan to run?

Ans:
Usually, a testplan contains a big number of test cases. For some reason, you don't want to run all test cases in the testplan. You want to select a group of test cases
and run them:
   1. Open the testplan.
   2. Select the test description line (linked to the testcase) to mark.
   3. Click Testplan/Mark menu. The selected test description line is marked.
   4. Repeat this process to select more linked testcases.
   5. Click the Run/Run Marked Tests menu. SilkTest runs all the marked testcases.
   6. Do not touch mouse or keyboard, to avoid interrupting the test case execution.
   7. SilkTest finishes executing the testcase. The Restuls window shows up with the execution result.
   8. Review the execution result.
View All Answers

Question - 99:
Is there a better way to generate a random integer than SilkTests RandInt() function?

Ans:
Is there a better way to generate a random integer than SilkTest's RandInt() function? I need true random numbers that going through a loop will give a diffrent
random number each time. How RandInt does it is you get the same number on a fast loop.
I did make a RandomInt() function (see below), which helps on general random numbers since it is using RandSeed(), but on a loop that just grabs some random
numbers, I still get the same numbers.
Anyone have a better way?
[CODE]
[ ] // Function: RandomInt
[ ] // Arguments: 1) iMin = Integer of Minimal value
[ ] // 2) iMax = Integer of maxium value
[ ] // Returns: random integer withing iMin and iMax
[-] INTEGER RandomInt(INTEGER iMin, INTEGER iMax, INTEGER iSeed optional)
[ ] INTEGER iRandom
[ ]
[-] if (iSeed == NULL)
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[ ] iSeed = GetDateTimePart (GetDateTime (), DTP_SECOND) * GetDateTimePart (GetDateTime (), DTP_SECOND)
[ ]
[ ]
[ ] RandSeed (iSeed)
[ ] iRandom = RandInt(iMin, iMax)
[ ]
[-] if (DEBUG)
[ ] print ("Random Seed = {iSeed} Random Int = {iRandom}")
[ ]
[ ] return iRandom
[ ]
[/CODE]
Answer1:
Most programming languages provide random number based on what is called a pseudo-random sequence. This provides the appearance of random selection via a list
that is seeded automatically by the system or by a command by the programmer. Either way it is still a randomized repeating list.
I don't know what to tell you except that you could try to reseed the generator after some number of iterations. the number of iterations could be randomized to vary
the reseed interval. The seed could be based on a number representing the number of seconds (in integer form) since some fixed point in the past. This process
probably would not repeat but sequences of integers could repeat unless the pseudo-random sequence is itself randomized by the seed instead of just the starting point
within the sequence. I don't know the answer to that one. Otherwise your best hope might be a dll designed to provide a random number.
Answer2:
Try to have your function sleep a random time (1-3 seconds or so) and after the sleep call the RandInt () function.
You sort of call the RandInt twice one in each other. that doubles your Randomness chances.
View All Answers

Question - 100:
Can SilkTest switch browsers automatically?

Ans:
You can, but there's a few steps that need to be done.
You need to use Organizer to do this. There you can re-run the same testcases but at the top open a different .opt (options) file. You have to save these 2 opt files
though after you set the runtime with Netscape, save the 1st one and save another after you set it up with IE.
Read more about organizer to learn more.
View All Answers

Question - 101:
How to Setting Max value?

Ans:
Here's the function you need to verify that an object (TextField) accepts a max char limit.
[code]
[+] boolean VerifyMaxChars (window wTarget, integer iMax, string sChar optional)
[ ]
[ ] string sText = ""
[ ] string sComp
[ ]
[+] if sChar == null
[ ]
[ ] sChar = "A"
[ ]
[ ]
[ ] sText = Replicate (sChar, iMax)
[ ]
[ ] wTarget.TypeKeys (sText)
[ ]
[ ] sComp = wTarget.GetText ()
[ ]
[+] if sText != sComp
[ ]
[ ] Verbose ("Verify Max Chars failed, expected number {iMax}, actual {Len (sComp)}")
[ ]
[ ] return false
[ ]
[ ]
[ ] sText = Replicate (sChar, iMax + 1)
[ ]
[ ] wTarget.SetText (sText)
[ ]
[ ] sComp = wTarget.GetText ()
[ ]
[+] if sText == sComp
[ ]
[ ] Verbose ("Verify Max Chars failed, expected number {iMax}, actual {iMax + 1}")
[ ]
[ ] return false
[ ]
[ ]
[ ] return true
[ ]
[/code]
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Question - 102:
WhaIs there a specific way to run a script from a point what I prefer, which is similar to run from cursor option in Winrunner? Any patch, adding, etc that enables this
option in Silk.?

Ans:
I don't think run from cursor is available in Silk......In this case, I comment the lines above, change the appstate to none and run...
View All Answers

Question - 103:
I have a GUI similar to Find Dialogue Box in Notepad..... Here the Check Box Match Case is recognized as Push Button and I want to check whether the check box
has been checked or not..... I can not map a standard class PushButton to another class "CheckBox"....In the Window declaration I manually changed the PushButton
class to CheckBox class but not working...
Please suggest any solution?

Ans:
Answer1: 1. Try to find the class of that object by using Window Identifier. Sometimes it already mapped.
2. If it is developed by VB or C++, try to use ActiveX properties.
Question 2:
I checked and the class is not mapped..... The application has been developed in C++.....can you share some information on how to use ActiveX properties using
Silk....
Answer2:
I think, you have to add your application in the extension enabler and check ActiveX Properties. See the help for " ActiveX: enabling support for"
View All Answers

Question - 104:
An application developed using Dotnet. and 1000 cases recorded for this application.
All was working fine until...one fine day...
Some one changed the namespaces which are used by this application. The scripts have started failing because it is as good as having a new window or a panel in the
application.
Obviously, Silk does not recongnise this window.
Now is there any way to tackle this problem other than recording the windows all over again.?

Ans:
Answer1:
First capture few windows and compare the new window declarations with old ones.
And try to find what are the changes in tags (Names) and any layers between windows.
Accordingly you just need to modify the few window identifies and need to include additional windows if any. ( you need not to touch your 1000 testcases ). Long
back I had same problem with this method I solved.
Answer2:
If you are very sure that only the namespace name change has impact on the scripts then I can suggest you one approach.
I am assuming the following, Suppose the previous namespace name is "x" & now it is "y". And all your scripts are in a single folder say "F"
You need to write a script in any language C# or our own 4T language, that need to search all through the folder "F" and replace all the "X" with "Y" in each and
every file.
This is the general way I go ahead when need to update one object in n number of files.
View All Answers

Question - 105:
How to get the integer value from a string ?

Ans:
How to get the integer value from a string
print([int]"100")
this returns some different value some 49
need the value 100 to be print
Answer1:
There is one inbuild Silk's function which converts String value into Integer. Try with that
INTEGER iTemp = Val ("100")
Answer2:
Use Val function.....
print (Val("100"))...The int wrapper returns the ASCII value for the string "100"...
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Question - 106:
How silktest recognize objects in UI? What it intenally calls to find out that the particular UI element is of which class etc?

Ans:
Silk recognizes a UI with the tag it assigns to the UI.....There are 5 tags, see silk help for them...Some of it are operating system specific......
Go to Silk-->Record-->Window declaration.......Move the mouse pointer to the object for which you want to know the class.......It is shown in the tree view in the
record dialogue box....
You can also do by Silk-->Record-->Window Identifier .....
View All Answers

Question - 107:
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A problem with SilkTest seeing HTML Links as HTMLText?

Ans:
A problem with SilkTest seeing HTML Links as HTMLText. This always happens when the link is within a table (which is inside a table, which is inside another
table).
In some areas I found if I put a space between the <TD> tag and the anchor tag, SilkTest will read the link as an HTMLLink. However, this trick doesn't always
works. Infact, it only works in about 20% of the cases.
Has anyone else encountered this? Anyone know of a workaround?
Is there anything you want to do with these links that you cannot do now?
Even if they are recognized as Text, can't you do almost anything you can do on a link. Example Click () etc...
You can also choose to extend the HtmlText class to have the same methods as HtmlText.
View All Answers

Question - 108:
What is a test frame?

Ans:
A test frame is a file that contains information about the application you are testing. Information stored in a test frame will be used as references when SilkTest
records and executes testcases. A test frame is stored in an include file with file extension .inc.
View All Answers

Question - 109:
SilkTest runtime does not always get control (focus) after a test?

Ans:
On Windows 98 or Windows 2000, if SilkTest launches but will not fully exit after execution of tests (leaving a blinking "SilkTest" window on the task bar).
This is due to a problem with Windows. The directory "W98_2000" on your SilkTest installation CD includes a file that should prove helpful. To perform this fix
manually, use RegEdit to modify the following key in the registry of the computer running SilkTest:
HKEY_CURRENT_USERControl PanelDesktop
"ForegroundLockTimeout"=dword:000003E8
View All Answers

Question - 110:
GMO OnLine Trouble?

Ans:
[I've already worked around the problem I'm having, but I'm curious know if anybody else has gotten this to work without a workaround.
This pertains to GMO Online.
I've tried using GMOW.inc which came with SilkTest 5.0, and that was after my own declaration had problems.
The problems are:
1- The SameAs checkbox is non checkable?
2- The Fields on the ShipTo side give me problems even if I try to use the GMOW.inc.
3- SetText for HtmlTextFields has problems, where it does not set text sometimes, and others it leaves some of the old chars in there (like 0).
Now for my workarounds:
1- Used Keyboard (Tabs and Space)
2- I've changed the declaration tags to Index 1st then Caption Second for all the ShipXXX and BillXXX fields.
3- I've Over-Ridden SetText to do it twice for HtmlTextField class.]
Yes, I have seen this problem from time to time. In class, I most often insert a Tab key in between each line. I have not seen this problem (to the best of my
recollection) when running Netscape 4.07 on NT. I haven't found out why this is happening though (if it's due to the agent, the GMO app, or the environment).
View All Answers

Question - 111:
How to create group and sub group descriptions in a testplan? Can SilkTest Verify Locations of Ads?

Ans:
Yes you can, but.....
The location may vary from 1 system to another? from one resolution to another.
You can use the .GetRect () method. Or you can use the verify properties (hold ctrl-shift while recording testcases)and select the location for a property.
View All Answers

Question - 112:
Need help to create Frame Work with Web testing 
1) Should I do window declaration for each page 
2) Should I do window declaration with multiple tag 
3) Which multitag should I choose?

Ans:
Anwser 1:
1) Should I do window declaration for each page Not necessarily but in most probability, u will have to do it. However, you don't need to declare every object in
every page. You need to make use of inheritance so that an object declared in main class can be inherited to sub classes.
2) Should I do window declaration with multiple tag You can use multi tag to declare windows. When I say multi, you can use different captions of the window.
3) Which multitag should I choose Caption
From my experience, this multi tag should be WindowID.
Let me explain,
If you have two instances of the same application running, (obviously, both will have same caption), a conflict arises. In such a situation, Silk Test script fails.
To avoid this condition, Window ID can be used, because, even if two instances are running at a time, the window ID's would still be unique.
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Anwser 2:
For Web based windows, dialogs, Window IDs are not much useful. Now silktest is identifying the object's variable name in source code. It will be similar to window
ID. For stand alone applications, Win ID will be useful. Even if you look into silktest's INC files, you can see window ID.
While coming to duplicates of windows, then you can use window location, index and window ID. Mostly people are using Index like calc[1],calc[2],#1 and #2.
Rarely ID and location (points X&Y) are used. I'm using location to some of modal dialogboxes in our AUT.
View All Answers

Question - 113:
What are the functions offered by DBTester?

Ans:
DBTester offers 6 functions. You can use them directly in your test cases:
   1. DB_Connect: Opens a database connection linking the data through the specified OBDC DSN name. DB_Connect returns a connection handle which can be used
on other DBTester functions. SQL statements can be submitted to the database. For example: con = DB_Connect("dsn=dsn_name")
   2. DB_Disconnect: Closes the database connection represented by the speficied connection handle. All resources related to this connect are also released. For
example: DB_Disconnect(con)
   3. DB_ExecuteSql: Sends the specified SQL statement to the specified database connection for execution. DB_ExecuteSql returns a query result handler which can
be used by the DB_FetchNext function. For example: res = DB_ExecuteSql(con, "SELECT * FROM ...")
   4. DB_FetchNext: Retrieves the next row from the specified query result handler. For example: DB_FetchNext(res, col1, col2, col3, ...)
   5. DB_FetchPrevious: Retrieves the previous row from the specified query result handler.
   6. DB_FinishSql: Closes the specified query result handler. For example: DB_FinishSql(res)
View All Answers

Question - 114:
How to link an error in the result file to the script file?

Ans:
1. Make sure the Result window is open with result file.
   2. Click Results/Pass/Fail Report. The Pass/Fail Report dialog box shows up.
   3. Select an attribute on which you want the report to be based on. For example: Component.
   4. Click the Generate button.
   5. SilkTest generates a report in the Pass/Fail Report dialog box.
   6. You can print or export the report.
   7. Click the Close button to close the Pass/Fail Report dialog box.
View All Answers

Question - 115:
Problem with the VerifyBitmap

Ans:
Using VerifyBitmap function for comparing the Position, Borders, Color etc.
For Example:
Window.VerifyBitmap("Position.bmp",[Rect])
Window.VerifyBitmap("Border.bmp",[Rect])
Window.VerifyBitmap("Color.bmp",[Rect])
Running the script if any one of the verification failed, script is terminating at that point itself, without running remaining lines in the script.
Is it possible to make script run completely even though any of the verification failed? Want to see all the failed verified results in result window.
Answer1:
Put all the verification statements in individual do...except.....You can keep except part blank or display your error message here.....
Answer2:
That is how below three functions will work.
VerifyBitmap()
VerifyProperties ()
Verify ()
that should be last statement of your testcase and cleanup code you put after that but, that will get executed only when testcase pass. You can put it in except block so
that it will get executed even testcase fails also Like below
do
//
//
//your statements
//
//
VerifyBitmap()
except
// your remaining statements those need to be executed only when testcase fails.
Or
use SYS_CompareBitmap() instead of VerifyBitmap()
View All Answers

Question - 116:
How can we get the IP address of a PC?

Ans:
You can use the following
main
[ ] INTEGER iReturn
[ ] STRING sCmdLine = "ipconfig"
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[ ] LIST OF STRING lsOutput
[ ] iReturn = SYS_Execute (sCmdLine , lsOutput)
[ ] listprint(lsOutput)
output is
[ ] Windows IP Configuration
[ ] Ethernet adapter Local Area Connection:
[ ] Connection-specific DNS Suffix . : abcd.xyz.net
[ ] IP Address. . . . . . . . . . . . : 1x.2xx.2xx.79
[ ] Subnet Mask . . . . . . . . . . . : 255.255.0.
[ ]Default Gateway . . . . . . . . . : 10.206.1.1
You need to do some trickery to parse and get the IP string..
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Question - 117:
How to maintain global variable when script is run thru test plans?

Ans:
Answer1:
This is the feature of Silk Test.
When u declare some global variables and initialize them in a testcase in one .t file, they are not retained to be used in another .t file in a testplan.
Here is the way out ...
Create a file and save the values in this file before u exit from the .t file.
This can be your last testcase in a file.
In the next .t file in the sequence, read this file and initialize global variables again.
This can be your first testcase in the .t file.
Answer2:
try couple of things
1. use environment variable as suggested by an other member of this group
2. copy the variable to the clipboard, every automation tool has a way to write and read content from clipboard which does not effect scope of the script.
Answer3:
I have one more solution for this problem try it out.
External file method (preferably .ini file - use ReadIni (), WriteIni () and few other functions).
Override your TestcaseEnter () and TestCaseExit () functions to get and set variable (reading values should be in called TestCaseEnter () and writing back the values
in TestCaseExit ())
Even testcase failure also you will not loose the values
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Question - 118:
How to write a Masterplan?

Ans:
[I want many plans and testcases to run by a single file. As Master plan-Sub plan are good medium since it gives me sharing features. Can anybody tell me how to run
sub plans from the masterplan with an example.]
Yaa, you can run all your sub-plans using master plan approach.
You just open new plan file and call your subplan/testcase from this file.
if you want to run subplan from master plan then sysntax is like
include: mysubplan.pln
View All Answers

Question - 119:
How to record a test case?

Ans:
1. Run SilkTest.
   2. Click Option/Runtime menu. The Runtime Options dialog box shows up.
   3. Edit the Use Files field to include your test frame file and the exlorer.inc file. For example: ...HomeFrame.inc,extendexplorer.inc.
   4. Make sure IE 5.x DOM is selceted.
   5. Click OK to cloase the Runtime Optoins dialog box.
   6. Open your test project.
   7. Click Record/Testcase menu. The Record Testcase dialog box shows up.
   8. Name your test case. For example: LoginTest.
   9. Select DefaultBaseState in the Applicatin State dropdown list.
  10. Click Start Recording button.The Record Testcase dialog closes. Your Web application is will be automatically started by SilkTest, based on the information in
test frame file. SilkTest Editor window closes. The Record Status dialog box shows up.
  11. Continue to use your Web application. SilkTest records everything you did on your application.
  12. Click the "Done" button on the Recording Status dialog box to stop recording. The Recording Status dialog box closes. The Record Testcase dialog box shows
up again.
  13. Click Paste to Editor. SilkTest will insert the recorded acitivities as 4Test statements into a script file. The Record Testcase dialog closes.
  14. Click File/Save menu to save the script file. You can enter a script file name. For example, LoginTest.t.
View All Answers

Question - 120:
How to write function in inc file?

Ans:
After you wrote the functions in inc ( eg:- demo.inc) you need to specify them in Use path/Use File
In Silk Test-> Options-> Run time
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Specify the inc file path/File name in "Use File" Text box
(or)
Secify the file Path in "Use Path" and added the file name in "Use File" text box
(or)
In your script file add code like
[] use "demo.inc"
and add the inc file path in Silk Test-> Options-> Run time -> Use Path
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Question - 121:
Problem with JavaJFCTable class.

Ans:
[I am trying to fetch values from a JavaJFCTable. I tried using GetContents, GetSelText, etc functions to retrieve values fromr the table but every time garbage values
are retrieved. Has anyone faced such a problem before?
the application is recognized properly with no Custom objects in it.]
View All Answers

Question - 122:
What are testplan attributes?

Ans:
Testplan attributes are user defined characteristics to be associated with test group descriptions and/or test descriptions. You search, identify, and/or report test cases
based on values of the different attributes.
View All Answers

Question - 123:
How to maintain recovery system?

Ans:
In your TestCaseExit () function you can incorporate like
If condition == 1
do this
If condition == 2
do that
View All Answers

Question - 124:
Retrieve text from disable textfield.Silk is not recognizing that disable object. How can I come to a conclusion?

Ans:
Retrieve text from disable textfield.Silk is not recognizing that disable object. How can I come to a conclusion? I am having a web based application. In one web page
there is a radio button.Selection of that radio button open an applet window. Now if I want to take the declaration of that window, It fails to recognise the same.Silk is
properly configured to recognise Java based CS application.How to resolve such issues?
If you want to retrieve data from a disabled textfield, you should first disable the Agent option "OPT_VERIFY_ENABLED" and the you can use GetText. The steps
are:
Agent.SetOptions("OPT_VERIFY_ENABLED", false)
Print(TextField.GetText())
And coming to your next question, the answer is same, disable all the Agent options. Steps:
1.In the Options menu, click on Agent menu item.
2. In Agent Options window, click on Verification tab.
3. Uncheck all the options, except the last one (verification of application ready)
4. Click OK.
View All Answers

Question - 125:
I am investigating solutions for automating an Invisible Application and believe that using a Grid may solve many of my problems. Does anyone have any experience
using this technique with Silk Test or know of any good resources I could contact.?

Ans:
Answer1:
If you use QA Partner, you should know, what to work it is possible only with one application, because include file (xxxxx.inc) only one. You can work it is possible
with different windows, but only from one application.
Answer2:
As far as the QA Partner list - I would say it is dead. The SilkTest list at Onelist.com (this list) is much better anyway, since all the messages are archived for people
to go back and search on. Plus, each user can control how they want it - each message or in digest mode.
Answer3:
As I know, you can work with several applications simultaneuosly. QA Partner/SilkTest doesn't limit you from that. You can run into the problem with using the
default recovery system for all applications under test, but this problem can be solved too.
View All Answers

Question - 126:
Prob regarding close the Child Window

Ans:
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Answer1:
1. Identify the process handle and
2. kill it First child and then the MainWindow.
Answer2:
Integer HWnd=Browser.GetHandle() ///before child popup opens
....then your code
While Browser2.Exists()
{
If Browser.GetHandle()!=HWnd
Browser.Close()
Else
Browser2.SetActive()
}
You can also use window caption in the former code.
Answer3:
I think the tag to identify the parent and child are not unique, that is why the parent is closed...try to make the window id unique and then close the page...
First activate the child using and then close....It should work....
View All Answers

Question - 127:
What is stored in a test frame?

Ans:
A test frame is a text file, which records the following types of information for a Web application:
   1. Comment: Commentary information.
   2. wMainWindow: A string constant to identify your application's home page.
   3. Home page window: An object of class BrowserChild window that holds application home page.
   4. sLocation: The URL of the your application's home apge.
   5. sUserName and dPassword: User name and password if needed to login to your Web application.
   6. BrowserSize: A pair of values to indicate the size of the browser window.
   7. Home page objects: A list of all objects on the home page, such as HtmlImage, HtmlText, HtmlLinks, etc.
View All Answers

Question - 128:
What is the syntax of UI object identifier used by DOM extension?

Ans:
The DOM browser extension uses the following syntax for Web UI objects:
   Browser.BrowserChild("page_title").html_class("object_tag")
   1. "page_title" is the title of the Web page, defined by the HTML <TITLE> tag.
   2. "object_tag" is the label of the HTML element. How a HTML element is labeled depending on the type of HTML element.
View All Answers

Question - 129:
How to add objects of other pages to a test frame?

Ans:
If your Web application has pages other than the home page, you should also record their page objects into the test frame:
   1. Make sure your Web browser is active and showing another page of your Web application.
   2. Make sure SilkTest is running.
   3. Click File/Open menu.
   4. Select your test frame file. For example: HomeFrame.inc.
   5. Click OK to open the test frame.
   6. Click Record/Window Declarations menu. The Record Window Declarations dialog box shows up.
   7. Click your Web application window. Web page objects are recorded in the Record Window Declarations dialog box.
   8. Press Ctrl+Alt to pause the recording.
   9. Click "Paste to Editor" button. All recorded objects will be inserted into the test frame.
  10. Repeat this for other Web pages, if needed.
View All Answers

Question - 130:
What are the types of text lines in a testplan file?

Ans:
A testplan file contains text lines. There are 5 types of text lines in a testplan file:
   1. Comment - Marked in green color: Providing commentary information.
   2. Group descriptiton - Marked in black color: Providing descriptions for groups of tests. Tests in a testplan can be grouped into multiple levels of groups.
   3.
   4. Test description - Marked in blue color: Providing descriptions for individual test.
   5. Testplan statement - Marked in dark red color: Providing relations to link scripts, testcases, test data, closed sub testplans or an include file to the testplan.
   6. Open subplan file marker - Marked in magenda color: Providing relations to link sub testplans to be included in a master testplan.
View All Answers

Question - 131:
How to get button caption?
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Ans:
Answer1:
Use GetCaption () method......
Answer2:
Either use "sCaption" Property or "GetCaption" Method
Syntax - ControlName.sCaption
or use GetCaption () Method
Syntax - ControlName.GetCaption ()
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Question - 132:
What is a SilkTest Testplan?

Ans:
The SilkTest testplan is an outline that provides a framework for the software testing process and serves as the point of control for organizing and managing your test
requirements. A testplan consists of two distinct parts: an outline, which is a formatted description of the test requirements, and statements, which are used to connect
the testplan to SilkTest scripts and testcases that implement the test requirements.
View All Answers

Question - 133:
How to create a new SilkTest project?

Ans:
1. Run SilkTest.
   2. Select Basic Workflow bar.
   3. Click Open Project on the Workflow bar.
   4. Select New Project.
   5. Double click Create Project icon in the New Project dialog box
   6. One the Create Project dialog box, enter your project name, and your project description.
   7. Click OK.
   8. SilkTest will create a new subdirectory under SilkTest project directory, and save all files related to the new project under that subdirectory.
View All Answers

Question - 134:
What is the Segue Testing Methodology?

Ans:
Segue testing methodology is a six-phase testing process:
   1. Plan - Determine the testing strategy and define specific test requirements.
   2. Capture - Classify the GUI objects in your application and build a framework for running your tests.
   3. Create - Create automated, reusable tests. Use recording and/ or programming to build test scripts written in Segue's 4Test language.
   4. Run - Select specific tests and execute them against the AUT.
   5. Report - Analyze test results and generate defect reports.
   6. Track - Track defects in the AUT and perform regression testing.
View All Answers

Question - 135:
What is SilkTest Agent?

Ans:
SilkTest Agent is a SilkTest component that receives testing commands from the SilkTest Host and interacts with AUT (Application Under Test) directly. SilkTest
Agent usually runs on the same machine where AUT is running.
View All Answers

Question - 136:
What is the DOM browser extension?

Ans:
Document Object Model (DOM) browser extension is a SilkTest add-on component for testing Web applications. DOM browser extension communicates directly
with the Web browser to recognize, categorize and manipulate objects on a Web page. It does this by working with the actual HTML code, rather than relying on the
visual pattern recognition techniques currently employed by the Virtual Object (VO) extension.
View All Answers

Question - 137:
Is there any problem in using scripts created on v6.0 to 6.5 or higher versions?

Ans:
Moving from lower to higher version should not be a problem....
This is a general statement and cannot be true at all instances.
I faced problems with scripts working in 6.5 not running in 7.0 because some of the recognition patterns used each changed. And in some situations, finally landed
two paths of the script to perform same action based on version.
PS: Did not encounter any problems from 6.0 to 6.5.
View All Answers
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Question - 138:
What is SilkTest project?

Ans:
A SilkTest project is a collection of files that contains required information about a test project.
View All Answers

Question - 139:
Is There any function for word count of web page is available in the SilkTest?

Ans:
You can use Clipboard functions. Get All the contents by Ctrl+a & ctrl+C. Then parse the List of sting ...
View All Answers

Question - 140:
What is the best way to create a new test script?

Ans:
In Automation; creating test scripts involves basically two step:
1. Creating Test Data for all test cases.
2. Writing scripts for automating the test cases.
The first steps, is the outcome of analysis of what all data is required for all of your testcases to be executed. These all should be collected and scripts to be written so
that TEST DATA is ready.
The second steps, is basically the test case execution steps automation.
View All Answers

Question - 141:
How to close unexpected window?

Ans:
You meant to say one more browser window (Order Request) appearing apart from original window (Order Status)?
Answer1
If Order Request window is a popup.
Following code closes the active browser window if it is a popup:
[-] !(if Browser.ComboBox("#1").exists())
[ ] Browser.SetActive()
[ ] Browser.typekeys("")
Answer2
If Order Request window is a Browser window.(not a popup)
You can use the following code to close unwanted Browsers(like Order Request)
Order_Status.SetActive()
Browser.CloseOthers()
View All Answers

Question - 142:
I have recently encounterd a problem using Silk Test V3. When I record selecting a Menu Item it correctly records eg. Product.File.Exit.Pick()
But when I play it back it just selects the File Menu and fails to select Exit. The File Menu is not dropped, it is just highlighted.
The application is written in Visual C++ and is running on NT 4.
A couple if the menu items to work but that is about 2 out of 15 items. I can work around the problem using the menu short cut keys but would prefer to be simulating
using the mouse in some test cases. Any ideas?

Ans:
I have run into this problem before and it turned out to be a focus problem in the AUT. First, we need to understand how QAP/Silk selects menu items. It doesn't
really use the mouse. It uses the  key to highlight the menu bar and then arrows to the desired menu item. Try something out: Drive your application to the state
before the menu selection. Now manually type F-10 or Alt and see if the menu highlights and allows you to arrow to the menu item. I'm guessing that it is probably a
ChildWin or DialogBox that is really holding the focus and not passing the keyboard events to the MainWin. If this is the case, you need to explain to the developers
that they need to enable this so that you can continue with your automated testing. A trick around this problem is to do a YourProduct.Click () to force the focus to the
MainWin and then do the menu selection (YourProduct.File.Exit.Pick())
View All Answers

Question - 143:
What is the VO browser extension?

Ans:
Virtual Object (VO) browser extension is a SilkTest add-on component for testing Web applications. VO browser extersion uses sophisticated pattern recognition
techniques to identify browser-rendered objects. The VO extension sees Web pages as they appear visually; it does not read or recognize HTML tags in the Web
application code. Instead, the VO extension sees the objects in a Web page; for example, links, tables, images and compound controls the way that you do, regardless
of the technology behind them.
View All Answers

Question - 144:
What is 4Test?

Ans:
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4Test is a test scripting language used by SilkTest to compose test scripts to perform automated tests. 4Test is an object-oriented fourth-generation language. It
consists of 3 sets of functionalities:
   1. A robust library of object-oriented classes and methods that specify how a testcase can interact with an application's GUI objects.
   2. A set of statements, operators and data types that you use to introduce structure and logic to a recorded testcase.
   3. A library of built-in functions for performing common support tasks.
View All Answers

Question - 145:
What is SilkTest Host?

Ans:
SilkTest Host is a SilkTest component that manages and executes test scripts. SilkTest Host usually runs on a separate machine different than the machine where
AUT (Application Under Test) is running.
View All Answers

Question - 146:
What is SilkTest?

Ans:
SilkTest is a software testing automation tool developed by Segue Software, Inc.
View All Answers
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